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C H A P T E R 1
Introduction to the Cisco Firepower Management
Center Virtual Appliance

The Cisco Firepower Management Center Virtual Appliance (FMCv) brings full firewall functionality to
virtualized environments to secure data center traffic and multi-tenant environments. Firepower Management
Center Virtual can manage physical and virtual Firepower Threat Defense, Firepower NGIPS, and FirePOWER
appliances.

• Platforms and Support for the FMCv, on page 1
• Firepower Management Center Virtual Licenses, on page 3
• About Virtual Appliance Performance, on page 3
• Download the Firepower Management Center Virtual Deployment Package, on page 5

Platforms and Support for the FMCv
Memory and Resource Requirements

Each instance of the FMCv requires a minimum resource allocation—memory, number of CPUs, and disk
space—on the target platform to ensure optimal performance.

When upgrading the FMCv, check the latest Firepower Release Notes for details on whether a new release
affects your environment. You may be required to increase resources to deploy the latest version of Firepower.

Important

When you upgrade Firepower, you add the latest features and fixes that help improve the security capabilities
and performance of your Firepower deployment.

FMCv Requires 28 GB RAM for Upgrade (6.6.0+)

The FMCv platform has introduced a new memory check during upgrade. FMCv upgrades to Version 6.6.0+
will fail if you allocate less than 28 GB RAM to the virtual appliance.

We recommend you do not decrease the default settings: 32 GB RAM for most FMCv instances, 64 GB for
the FMCv 300. To improve performance, you can always increase a virtual appliance’s memory and number
of CPUs, depending on your available resources.

Important
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As a result of this memory check, we will not be able to support lower memory instances on supported
platforms. See About Virtual Appliance Performance, on page 3 for important FMCv upgrade information.

FMCv Initial Setup (6.5.0+)

Beginning with Version 6.5, the FMCv has an improved initial setup experience that includes the following
changes and enhancements:

• DHCP on Management—DHCP is enabled by default mode on the management interface (eth0).

The FMCv management interface is preconfigured to accept an IP4 address assigned by DHCP. Consult
with your system administrator to determine what IP address your DHCP has been configured to assign
to the FMCv. In scenarios where no DHCP is available, the FMC management interface uses the IPv4
address 192.168.45.45.

• Web interface URL—The default URL for the FMCv web interface has changed to
https://<FMC-IP>:<port>/ui/login.

• Password reset—To ensure system security and privacy, the first time you log in to the FMC you are
required to change the admin password. When the Change Password wizard screen appears, you have
two options: Enter a new password in the New Password and Confirm Password text boxes. The
password must comply with the criteria listed in the dialog.

• Network settings—The FMCv now includes an install wizard to complete the initial setup:

• Fully Qualified Domain Name—Accept the default value, if one is shown, or enter a fully qualified
domain name (syntax <hostname>.<domain>) or host name.

• Boot protocol for IPV4 connection—Choose either DHCP or Static/Manual as the method of IP
address assignment.

• DNS Group—The default Domain Name Server group for the FMCv is the Cisco Umbrella DNS.

• NTP Group Servers—The default Network Time Protocol group is set to the Sourcefire NTP
pools.

• RAM Requirements—The recommended size of RAM is 32GB for the FMCv.

• FMCv-300 for VMware—A new scaled FMCv image is available on the VMware platform that supports
managing up to 300 devices and has higher disk capacity.

Supported Platforms

The Cisco Firepower Management Center Virtual can be deployed on the following platforms:

• VMware vSphere Hypervisor (ESXi)—You can deploy the Firepower Management Center Virtual as
a guest virtual machine on VMware ESXi.

• Kernel Virtualization Module (KVM)—You can deploy the Firepower Management Center Virtual
on a Linux server that is running the KVM hypervisor.

• Amazon Web Services (AWS)—You can deploy the Firepower Management Center Virtual on EC2
instances in the AWS Cloud.

• Microsoft Azure—You can deploy the Firepower Management Center Virtual in the Azure Cloud.

Cisco Firepower Management Center Virtual Getting Started Guide
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High availability (HA) configuration is supported only on the Firepower Management Center Virtual
deployment on VMWare; see About Firepower Management Center High Availability in the Firepower
Management Center Configuration Guide for information about system requirements for high availability.

Note

Hypervisor and Version Support

For hypervisor and version support, see Cisco Firepower Compatibility.

Firepower Management Center Virtual Licenses
The Firepower Management Center Virtual License is a platform license, rather than a feature license. The
version of virtual license you purchase determines the number of devices you can manage via the Firepower
Management Center. For example, you can purchase licenses that enable you to manage two devices, 10
devices, 25 devices, or 300 devices.

About Firepower Feature Licenses
You can license a variety of features to create an optimal Firepower System deployment for your organization.
The Firepower Management Center allows you to manage these feature licenses and assign them to your
devices.

The Firepower Management Center manages feature licenses for your devices, but you do not need a feature
license to use a Firepower Management Center.

Note

Firepower feature licenses depend on your device type:

• Smart Licenses are available for Firepower Threat Defense and Firepower Threat Defense Virtual devices.

• Classic Licenses are available for 7000 and 8000 Series, ASA FirePOWER, and NGIPSv devices.

Devices that use Classic Licenses are sometimes referred to as Classic devices. A single Firepower Management
Center can manage both Classic and Smart Licenses.

In addition to "right-to-use" feature licenses, many features require a service subscription. Right-to-use licenses
do not expire, but service subscriptions require periodic renewal.

For detailed information about Smart vs. Classic licenses on each platform, see the Cisco Firepower System
Feature Licenses document.

For answers to common questions about Smart Licensing, Classic licensing, right-to-use licenses, and service
subscriptions, see the Frequently Asked Questions (FAQ) about Firepower Licensing document.

About Virtual Appliance Performance
It is not possible to accurately predict throughput and processing capacity for virtual appliances. A number
of factors heavily influence performance, such as the:
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• Amount of memory and CPU capacity of the host

• Number of total virtual machines running on the host

• Network performance, interface speed, and number of sensing interfaces deployed

• Amount of resources assigned to each virtual appliance

• Level of activity of other virtual appliances sharing the host

• Complexity of policies applied to a virtual device

If the throughput is not satisfactory, adjust the resources assigned to the virtual appliances that share the host.

Each virtual appliance you create requires a certain amount of memory, CPUs, and hard disk space on the
host. Do not decrease the default settings, as they are the minimum required to run the system software.
However, to improve performance, you can increase a virtual appliance’s memory and number of CPUs,
depending on your available resources.

FMCv Default and Minimum Memory Requirements

All FMCv implementations now have the same RAM requirements: 32 GB recommended, 28 GB required
(64 GB for FMCv 300). Upgrades to Version 6.6.0+ will fail if you allocate less than 28 GB to the virtual
appliance. After upgrade, the health monitor will alert if you lower the memory allocation.

These new memory requirements enforce uniform requirements across all virtual environments, improve
performance, and allow you to take advantage of new features and functionality. We recommend you do not
decrease the default settings. To improve performance, you can increase a virtual appliance’s memory and
number of CPUs, depending on your available resources.

As of the Version 6.6.0 release, lower-memory instance types for cloud-based FMCv deployments (AWS,
Azure) are fully deprecated. You cannot create new FMCv instances using them, even for earlier Firepower
versions. You can continue running existing instances.

Important

The following table summarizes pre-upgrade requirements for lower-memory FMCv deployments.

Table 1: FMCv Memory Requirements for Version 6.6.0+ Upgrades

DetailsPre-Upgrade ActionPlatform

Power off the virtual machine first.

For instructions, see the VMware
documentation.

Allocate 28 GB minimum/32 GB recommended.VMware

For instructions, see the documentation for your
KVM environment.

Allocate 28 GB minimum/32 GB recommended.KVM

Cisco Firepower Management Center Virtual Getting Started Guide
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DetailsPre-Upgrade ActionPlatform

Stop the instance before you resize. Note that
when you do this, data on the instance store
volume is lost, so migrate your instance
store-backed instance first. Additionally, if your
management interface does not have an Elastic
IP address, its public IP address is released.

For instructions, see the documentation on
changing your instance type in the AWS user
guide for Linux instances.

Resize instances:

• From c3.xlarge to c3.4xlarge.

• From c3.2.xlarge to c3.4xlarge.

• From c4.xlarge to c4.4xlarge.

• From c4.2xlarge to c4.4xlarge.

We also offer a c5.4xlarge instance for new
deployments.

AWS

Use the Azure portal or PowerShell. You do
not need to stop the instance before you resize,
but stopping may reveal additional sizes.
Resizing restarts a running virtual machine.

For instructions, see the Azure documentation
on resizing a Windows VM.

Resize instances:

• From Standard_D3_v2 to
Standard_D4_v2.

Azure

Download the Firepower Management Center Virtual
Deployment Package

You can download Firepower Management Center Virtual deployment packages from Cisco.com, or in the
case of patches and hotfixes, you can download from within the Firepower Management Center.

To download the Firepower Management Center Virtual deployment package:

Step 1 Navigate to the Cisco Software Download page.

A Cisco.com login and Cisco service contract are required.Note

Step 2 Click Browse all to search for the Firepower Management Center Virtualdeployment package.

Step 3 Choose Security > Firewalls > Firewall Management, and select Firepower Management Center Virtual Appliance.

Step 4 Choose your model > FireSIGHT System Software > version.

The following table includes naming conventions and information about Firepower Management Center Virtual software
on Cisco.com.

Cisco Firepower Management Center Virtual Getting Started Guide
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Package NamePackage TypeModel

Cisco_Firepower_Management_Center_Virtual_VMware-version.tar.gzFirepower software
install: VMware

Firepower
Management Center
Virtual

Cisco_Firepower_Management_Center_Virtual-version.qcow2Firepower software
install: KVM

Log into the cloud service and deploy from the marketplace.Firepower software
install: AWS

Log into the cloud service and deploy from the marketplace.Firepower software
install: Azure

Step 5 Locate the deployment package and download it to a server or to your management computer.

Many package names look similar, so make sure you download the correct one.

Download directly from the Cisco Support & Download site. If you transfer a deployment package by email, it may
become corrupted.

What to do next

Refer to the chapter that is applicable for your deployment platform:

• To deploy the Firepower Management Center Virtual as a guest virtual machine on VMware ESXi, see
Deploy the Firepower Management Center Virtual Using VMware, on page 7.

• To deploy the Firepower Management Center Virtual on a Linux server running the KVM hypervisor,
see Deploy the Firepower Management Center Virtual Using KVM, on page 19.

• To deploy the Firepower Management Center Virtual in AWS, see Deploy the Firepower Management
Center Virtual On the AWS Cloud, on page 31.

• To deploy the Firepower Management Center Virtual in Azure, see Deploy the Firepower Management
Center Virtual On the Microsoft Azure Cloud, on page 43.

Cisco Firepower Management Center Virtual Getting Started Guide
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C H A P T E R 2
Deploy the Firepower Management Center Virtual
Using VMware

You can deploy the Firepower Management Center Virtual (FMCv) using VMware.

• VMware Feature Support for the Firepower Management Center Virtual, on page 7
• Host System Requirements, on page 8
• Guidelines and Limitations for the FMCv and VMware, on page 11
• Download the Installation Package, on page 14
• Deploy Using VMware vSphere, on page 15
• Verify the Virtual Machine Properties, on page 17
• Power On and Initialize the Virtual Appliance, on page 18

VMwareFeatureSupport for theFirepowerManagementCenter
Virtual

The following table lists the VMware feature support for the FMCv.

Table 2: VMware Feature Support for the FMCv

CommentSupport (Yes/No)DescriptionFeature

¯
NoThe VM is powered off during

cloning.
Cold Clone

¯
NoThe VM is running during an

addition.
Hot add

¯NoThe VM is running during cloning.Hot clone

¯NoThe VM is running during removal.Hot removal

Cisco Firepower Management Center Virtual Getting Started Guide
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CommentSupport (Yes/No)DescriptionFeature

There is a risk of
out-of-sync situations
between the FMC and
managed devices. See
Snapshots Support, on
page 12

.

NoThe VM freezes for a few seconds.Snapshots

¯
YesThe VM is suspended, then

resumed.
Suspend and
resume

¯
NoAllows automatic deployment of

VMs.
vCloud Director

¯
YesThe VM is powered off during

migration.
VM migration

Use shared storage. See
vMotion Support, on page
12.

YesUsed for live migration of VMs.vMotion

¯NoUsed for HA on VMs.VMware FT

¯YesUsed for ESXi and server failures.VMware HA

¯NoUsed for VM failures.VMware HA
with VM
heartbeats

¯

YesUsed to deploy VMs.VMware
vSphere
Standalone
Windows Client

¯
YesUsed to deploy VMs.VMware

vSphere Web
Client

Host System Requirements
FMCv Requires 28 GB RAM for Upgrade (6.6.0+)

The FMCv platform has introduced a new memory check during upgrade. FMCv upgrades to Version 6.6.0+
will fail if you allocate less than 28 GB RAM to the virtual appliance.

Cisco Firepower Management Center Virtual Getting Started Guide
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We recommend you do not decrease the default settings: 32 GB RAM for most FMCv instances, 64 GB for
the FMCv 300. To improve performance, you can always increase a virtual appliance’s memory and number
of CPUs, depending on your available resources.

Important

As a result of this memory check, we will not be able to support lower memory instances on supported
platforms.

Memory and Resource Requirements

You can deploy the Firepower Management Center Virtual using VMware vSphere provisioning hosted on
VMware ESX and ESXi hypervisors. See the Cisco Firepower Compatibility Guide for hypervisor compatibility.

When upgrading the FMCv, check the latest Firepower Release Notes for details on whether a new release
affects your environment. You may be required to increase resources to deploy the latest version of Firepower.

Important

When you upgrade Firepower, you add the latest features and fixes that help improve the security capabilities
and performance of your Firepower deployment.

The specific hardware used for FMCv deployments can vary, depending on the number of instances deployed
and usage requirements. Each virtual appliance you create requires a minimum resource allocation—memory,
number of CPUs, and disk space—on the host machine.

The following table lists the recommended and default settings for the FMCv appliance.

Be sure to allocate enough memory to ensure the optimal performance of your FMCv. If your FMCv has less
than 32 GB memory, your system could experience policy deployment issues. To improve performance, you
can increase a virtual appliance’s memory and number of CPUs, depending on your available resources. Do
not decrease the default settings, as they are the minimum required to run the system software.

Important

Table 3: FMCv Virtual Appliance Settings

Adjustable Setting?RecommendedDefaultMinimumSetting

With restrictions.

The FMCv platform has
introduced a new
memory check during
upgrade. FMCv
upgrades to Version
6.6.0+ will fail if you
allocate less than 28 GB
RAM to the virtual
appliance.

Important

32 GB32 GB28 GBMemory

Yes, up to 8844Virtual CPUs

Cisco Firepower Management Center Virtual Getting Started Guide
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Adjustable Setting?RecommendedDefaultMinimumSetting

No, based on Disk Format selectionn/a250 GB250 GBHard disk
provisioned size

Table 4: FMCv300 Virtual Appliance Settings

Adjustable Setting?DefaultSetting

Yes64 GBMemory

No32Virtual CPUs

No, based on Disk Format selection2.2 TBHard disk
provisioned size

Systems running VMware vCenter Server and ESXi instances must meet specific hardware and operating
system requirements. For a list of supported platforms, see the VMware online Compatibility Guide.

Support for Virtualization Technology

The computer that serves as the ESXi host must meet the following requirements:

• It must have a 64-bit CPU that provides virtualization support, either Intel® Virtualization Technology
(VT) or AMD Virtualization™ (AMD-V™) technology.

• Virtualization must be enabled in the BIOS settings

Both Intel and AMD provide online processor identification utilities to help you
identify CPUs and determine their capabilities. Many servers that include CPUs
with VT support might have VT disabled by default, so you must enable VT
manually. You should consult your manufacturer's documentation for instructions
on how to enable VT support on your system.

Note

• If your CPUs support VT, but you do not see this option in the BIOS, contact your vendor to request a
BIOS version that lets you enable VT support.

• To host virtual devices, the computer must have network interfaces compatible with Intel e1000 drivers
(such as PRO 1000MT dual port server adapters or PRO 1000GT desktop adapters).

Verify CPU Support

You can use the Linux command line to get information about the CPU hardware. For example, the
/proc/cpuinfo file contains details about individual CPU cores. Output its contents with less or cat.

You can look at the flags section for the following values:

• vmx—Intel VT extensions

• svm—AMD-V extensions

Use grep to quickly see if any of these values exist in the file by running the following command:

Cisco Firepower Management Center Virtual Getting Started Guide
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egrep “vmx|svm” /proc/cpuinfo

If your system supports VT, then you should see vmx or svm in the list of flags.

Guidelines and Limitations for the FMCv and VMware
OVF File Guidelines

Virtual appliances use Open Virtual Format (OVF) packaging. You deploy a virtual appliance with a virtual
infrastructure (VI) or ESXi OVF template. The selection of the OVF file is based on the deployment target:

• For deployment on vCenter—Cisco_Firepower_Management_Center_Virtual_VMware-VI-X.X.X-xxx.ovf

• For deployment on ESXi (no
vCenter)—Cisco_Firepower_Management_Center_Virtual_VMware-ESXi-X.X.X-xxx.ovf

where X.X.X-xxx is the version and build number of the Firepower System software you want to deploy. See

• If you deploy with a VI OVF template, the installation process allows you to perform the entire initial
setup for FMCv appliance. You can specify:

• A new password for the admin account.

• Network settings that allow the appliance to communicate on your management network.

You must manage this virtual appliance using VMware vCenter.Note

• If you deploy using an ESXi OVF template, you must configure Firepower System-required settings
after installation. You can manage this virtual appliance using VMware vCenter or use it as a standalone
appliance .

When you deploy an OVF template you provide the following information:

Table 5: VMware OFV Template Settings

ActionESXi or VISetting

Browse to the OVF templates you downloaded from
Cisco.com.

BothImport/Deploy OVF Template

Confirm the appliance you are installing (FMCv) and
the deployment option (VI or ESXi).

BothOVF Template Details

Agree to accept the terms of the licenses included in
the OVF template.

VI onlyAccept EULA

Enter a unique, meaningful name for your virtual
appliance and select the inventory location for your
appliance.

BothName and Location

Cisco Firepower Management Center Virtual Getting Started Guide
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ActionESXi or VISetting

Select the host or cluster where you want to deploy
the virtual appliance.

BothHost / Cluster

Manage your computing resources within a host or
cluster by setting them up in a meaningful hierarchy.
Virtual machines and child resource pools share the
resources of the parent resource pool.

BothResource Pool

Select a datastore to store all files associated with the
virtual machine.

BothStorage

Select the format to store the virtual disks: thick
provision lazy zeroed, thick provision eager zeroed,
or thin provision.

BothDisk Format

Select the management interface for the virtual
appliance.

BothNetwork Mapping

Customize the Virtual Machine initial configuration
setup.

VI onlyProperties

Time and Time Synchronization

Use a Network Time Protocol (NTP) server to synchronize system time on the FMCv and managed devices.
You typically specify NTP servers during the FMCv initial configuration; see Firepower Management Center
Virtual Initial Setup, on page 97 for the information about the default NTP servers.

Synchronizing the system time on your FMCv and its managed devices is essential to successful operation
of your Firepower System. You can take additional steps to ensure time synchronization when you configure
NTP on the VMware ESXi server to match the NTP settings of the FMCv.

You can use the vSphere Client to configure NTP on ESXi hosts. Consult VMware documentation for specific
instructions. Additionaly, the VMware KB 2012069 describes how to configuring NTP on ESX/ESXi hosts
using the vSphere Client.

vMotion Support

We recommend that you only use shared storage if you plan to use vMotion. During deployment, if you have
a host cluster you can either provision storage locally (on a specific host) or on a shared host. However, if
you try to vMotion the FMCv to another host, using local storage will produce an error.

Snapshots Support

A VMware snapshot is a copy of the virtual machine's disk file (VMDK) at a given point in time. Snapshots
provide a change log for the virtual disk and can be used to restore a VM to a particular point in time when
a failure or system error occurs. Snapshots alone do not provide backup, and should not be used as backup.

If you need configuration backups, use the backup and restore feature of the Firepower Management Center
(System > Tools > Backup/Restore).

The VMware snapshots functionality on ESXi can exhaust VM storage capacity and impact the performance
of the FMC virtual appliance. See the following VMware Knowledge Base articles:
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• Best practices for using snapshots in the vSphere environment (VMware KB 1025279).

• Understanding VM snapshots in ESXi (VMware KB 1015180).

High Availability (HA) Support

You can establish high availability (HA) between two FMCv virtual appliances on VMware ESXi.

• FMCv HA is supported on both FMCv models: FMCv and FMCv 300.

• The two FMCv virtual appliances in a high availability configuration must be the same model. You
cannot pair an FMCv with an FMCv 300.

• To establish FMCv HA, FMCv requires an extra Firepower Management Center Virtual (MCv) license
entitlement for each FTD device that it manages in the HA configuration. However, the required FTD
feature license entitlement for each FTD device has no change regardless of the FMCv HA configuration.
See License Requirements for FTD Devices in a High Availability Pair in the Firepower Management
Center Configuration Guide for guidelines about licensing.

• If you break the FMCv HA pair, the extra Firepower Management Center Virtual (MCv) license entitlement
is released, and you need only one entitlement for each FTD device.

See Establishing Firepower Management Center High Availability in the Firepower Management Center
Configuration Guide for guidelines about high availability.

INIT Respawning Error Messages Symptom

You may see the following error message on the FMCv console running on ESXi 6 and ESXi 6.5:

"INIT: Id "fmcv" respawning too fast: disabled for 5 minutes"

Workaround—Edit the virtual machine settings in vSphere to add a serial port while the device is powered
off.

1. Right-click the virtual machine and select Edit Settings.

2. On the Virtual Hardware tab, select Serial port from the New device drop-down menu, and click Add.

The serial port appears at the bottom of the virtual device list.

3. On the Virtual Hardware tab, expand Serial port, and select connection type Use physical serial port.

4. Uncheck the Connect at power on checkbox.

Click OK to save settings.

Limitations

The following limitations exist when deploying for VMware:

• FMCv appliances do not have serial numbers. The System > Configuration page will show either None
or Not Specified depending on the virtual platform.

• Cloning a virtual machine is not supported.

• Restoring a virtual machine with snapshot is not supported.

• VMware Workstation, Player, Server, and Fusion do not recognize OVF packaging and are not supported.
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Configure VMXNET3 Interfaces

Starting with the 6.4 release, FTDv and FMCv on VMware default to vmxnet3 interfaces when you create a
virtual device. Previously, the default was e1000. If you are using e1000 interfaces, we strongly recommend
you switch. The vmxnet3 device drivers and network processing are integrated with the ESXi hypervisor, so
they use fewer resources and offer better network performance.

Important

To change e1000 interfaces to vmxnet3, you must delete ALL interfaces and reinstall them with the vmxnet3
driver.

Although you can mix interfaces in your deployment (such as, e1000 interfaces on a virtual Firepower
Management Center and vmxnet3 interfaces on its managed virtual device), you cannot mix interfaces on the
same virtual appliance. All sensing and management interfaces on the virtual appliance must be of the same
type.

Step 1 Power off the FTDv or FMCv Virtual Machine.

To change the interfaces, you must power down the appliance.

Step 2 Right-click the FTDv or FMCv Virtual Machine in the inventory and select Edit Settings.

Step 3 Select the applicable network adapters and then select Remove.

Step 4 Click Add to open the Add Hardware Wizard.

Step 5 Select Ethernet adapter and click Next.

Step 6 Select the vmxnet3 adapter and then choose network label.

Step 7 Repeat for all interfaces on the FTDv.

What to do next

• Power on the FTDv or FMCv from the VMware console.

Download the Installation Package
Cisco provides packaged virtual appliances for VMware ESX and ESXi host environments on its Support
Site as compressed archive (.tar.gz) files. Cisco virtual appliances are packaged as virtual machines with
Version 7 of the virtual hardware. Each archive contains the OVF templates and manifest files for either an
ESXi or VI deployment target, and a virtual machine disk format (vmdk) file.

Download the Firepower Management Center Virtual installation package from Cisco.com, and save it to
your local disk. Cisco recommends that you always use the most recent package available. Virtual appliance
packages are usually associated with major versions of the system software (for example, 6.1 or 6.2).

Step 1 Navigate to the Cisco Software Download page.

A Cisco.com login and Cisco service contract are required.Note
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Step 2 Click Browse all to search for the Firepower Management Center Virtual deployment package.

Step 3 Choose Security > Firewalls > Firewall Management, and select Firepower Management Center Virtual Appliance.

Step 4 Find the VMware installation package that you want to download for the Firepower Management Center Virtual Appliance
using the following naming convention:

Cisco_Firepower_Management_Center_Virtual_VMware-X.X.X-xxx.tar.gz

where X.X.X-xxx is the version and build number of the installation package you want to download.

Step 5 Click the installation package you want to download.

While you are logged into the Support Site, Cisco recommends you download any available updates for virtual
appliances so that after you install a virtual appliance to a major version, you can update its system software.
You should always run the latest version of the system software supported by your appliance. For Cisco
Firepower Management Center Virtual, you should also download any new intrusion rule and Vulnerability
Database (VDB) updates.

Note

Step 6 Copy the installation package to a location accessible to the workstation or server that is running the vSphere Client.

Do not transfer archive files via email; the files can become corrupted.Caution

Step 7 Uncompress the installation package archive file using your preferred tool and extract the installation files. For the Cisco
Firepower Management Center Virtual:

• Cisco_Firepower_Management_Center_Virtual_VMware-X.X.X-xxx-disk1.vmdk

• Cisco_Firepower_Management_Center_Virtual_VMware-ESXi-X.X.X-xxx.ovf

• Cisco_Firepower_Management_Center_Virtual_VMware-ESXi-X.X.X-xxx.mf

• Cisco_Firepower_Management_Center_Virtual_VMware-VI-X.X.X-xxx.ovf

• Cisco_Firepower_Management_Center_Virtual_VMware-VI-X.X.X-xxx.mf

where X.X.X-xxx is the version and build number of the archive file you downloaded.

Make sure you keep all the files in the same directory.Note

What to do next

• Determine your deployment target (VI or ESXi) and continue with Deploy Using VMware vSphere, on
page 15.

Deploy Using VMware vSphere
You can use the VMware vSphere vCenter, vSphere Client, vSphere Web Client, or the ESXi hypervisor (for
standalone ESXi deployment) to deploy a Firepower Management Center Virtual. You can deploy with either
a VI or ESXi OVF template:

• If you deploy using a VI OVF template, the appliance must be managed by VMware vCenter.
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• If you deploy using a ESXi OVF template, the appliance can be managed by VMware vCenter or deployed
to a standalone ESXi host. In either case, you must configure Firepower System-required settings after
installation.

After you specify settings on each page of the wizard, click Next to continue. For your convenience, the final
page of the wizard allows you to confirm your settings before completing the procedure.

Step 1 From the vSphere Client, choose File > Deploy OVF Template.

Step 2 From the drop-down list, select the OVF template you want to use to deploy your Firepower Management Center
Virtual:

• Cisco_Firepower_Management_Center_Virtual_VMware-VI-X.X.X-xxx.ovf
• Cisco_Firepower_Management_Center_Virtual_VMware-ESXi-X.X.X-xxx.ovf

where X.X.X-xxx is the version and build number of the installation package you downloaded from Cisco.com.

Step 3 View the OVF Template Details page and click Next.

Step 4 If license agreements are packaged with the OVF template (VI templates only), the End User License Agreement
page appears. Agree to accept the terms of the license and click Next.

Step 5 (Optional) Edit the name and select the folder location within the inventory where the Firepower Management Center
Virtual will reside, and click Next.

When the vSphere Client is connected directly to an ESXi host, the option to select the folder location does
not appear.

Note

Step 6 Select the host or cluster on which you want to deploy the Firepower Management Center Virtual and click Next.

Step 7 Navigate to, and select the resource pool where you want to run the Firepower Management Center Virtual and click
Next.

This page appears only if the cluster contains a resource pool.

Step 8 Select a storage location to store the virtual machine files, and click Next.

On this page, you select from datastores already configured on the destination cluster or host. The virtual machine
configuration file and virtual disk files are stored on the datastore. Select a datastore large enough to accommodate the
virtual machine and all of its virtual disk files.

Step 9 Select the disk format to store the virtual machine virtual disks, and click Next.

When you select Thick Provisioned, all storage is immediately allocated. When you select Thin Provisioned, storage
is allocated on demand as data is written to the virtual disks.

Step 10 Associate the Firepower Management Center Virtual management interface with a VMware network on the Network
Mapping screen.

Select a network by right-clicking the Destination Networks column in your infrastructure to set up the network
mapping and click Next.

Step 11 If user-configurable properties are packaged with the OVF template (VI templates only), set the configurable properties
and click Next.

Step 12 Review and verify the settings on the Ready to Complete window.

Step 13 (Optional) Check the Power on after deployment option to power on the Firepower Management Center Virtual, then
click Finish.
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Note: If you choose not to power on after deployment, you can do so later from the VMware console; see Initializing
a Virtual Appliance.

Step 14 After the installation is complete, close the status window.

Step 15 After you complete the wizard, the vSphere Web Client processes the VM; you can see the “Initialize OVF deployment”
status in the Global Information area Recent Tasks pane.

When it is finished, you see the Deploy OVF Template completion status.

The Cisco Firepower Management Center Virtual instance then appears under the specified data center in the Inventory.
Booting up the new VM could take up to 30 minutes.

To successfully register the Firepower Management Center Virtual with the Cisco Licensing Authority, the
Firepower Management Center requires Internet access. You might need to perform additional configuration
after deployment to achieve Internet access and successful license registration.

Note

What to do next

• Confirm that the virtual appliance’s hardware and memory settings meet the requirements for your
deployment; see Verify the Virtual Machine Properties, on page 17.

Verify the Virtual Machine Properties
Use the VMware Virtual Machine Properties dialog box to adjust the host resource allocation for the selected
virtual machine. You can change CPU, memory, disk, and advanced CPU resources from this tab. You can
also change the power-on connection setting, the MAC address, and the network connection for the virtual
Ethernet adapter configuration for a virtual machine.

Step 1 Right-click the name of your new virtual appliance, then choose Edit Settings from the context menu, or click Edit
virtual machine settings from the Getting Started tab in the main window.

Step 2 Make sure the Memory, CPUs, and Hard disk 1 settings are set no lower than the defaults, as described in Default
Virtual Appliance Settings, page 4.

The memory setting and the number of virtual CPUs for the appliance are listed on the left side of the window. To see
the hard disk Provisioned Size, click Hard disk 1.

Step 3 Optionally, increase the memory and number of virtual CPUs by clicking the appropriate setting on the left side of the
window, then making changes on the right side of the window.

Step 4 Confirm the Network adapter 1 settings are as follows, making changes if necessary:

a) Under Device Status, enable the Connect at power on check box.
b) Under MAC Address, manually set the MAC address for your virtual appliance’s management interface.

Manually assign the MAC address to your virtual appliance to avoid MAC address changes or conflicts from other
systems in the dynamic pool.

Additionally, for virtual Cisco Firepower Management Centers, setting the MAC address manually ensures that you
will not have to re-request licenses from Cisco if you ever have to reimage the appliance.

c) Under Network Connection, set the Network label to the name of the management network for your virtual appliance.
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Step 5 Click OK.

What to do next

• Initialize the virtual appliance; see Power On and Initialize the Virtual Appliance, on page 18.

• Optionally, before you power on the appliance, you can create an additional management interface; see
the Cisco Firepower NGIPSv Quick Start Guide for VMware for more information.

Power On and Initialize the Virtual Appliance
After you complete the deployment of the virtual appliance, initialization starts automatically when you power
on the virtual appliance for the first time.

Startup time depends on a number of factors, including server resource availability. It can take up to 40 minutes
for the initialization to complete. Do not interrupt the initialization or you may have to delete the appliance
and start over.

Caution

Step 1 Power on the appliance.

In the vSphere Client, right-click the name of your virtual appliance from the inventory list, then select Power > Power
On from the context menu.

Step 2 Monitor the initialization on the VMware console tab.

What to do next

After you deploy a FMCv, you must complete a setup process to configure the new appliance to communicate
on your trusted management network. If you deploy with an ESXi OVF template on VMware, setting up a
FMCv is a two-step process.

• To complete the initial setup of the FMCv, see Firepower Management Center Virtual Initial Setup, on
page 97.

• For an overview of the next steps needed in your FMCv deployment, see Firepower Management Center
Virtual Initial Administration and Configuration, on page 105.

Cisco Firepower Management Center Virtual Getting Started Guide
18

Deploy the Firepower Management Center Virtual Using VMware
Power On and Initialize the Virtual Appliance



C H A P T E R 3
Deploy the Firepower Management Center Virtual
Using KVM

You can deploy the Cisco Firepower Management Center Virtual (FMCv) on KVM.

• About Deployment Using KVM, on page 19
• Prerequisites for Deployment Using KVM, on page 20
• Guidelines and Limitations, on page 21
• Prepare the Day 0 Configuration File, on page 22
• Launch the FMCv, on page 23
• Deploy Without the Day 0 Configuration File, on page 28

About Deployment Using KVM
KVM is a full virtualization solution for Linux on x86 hardware containing virtualization extensions (such
as Intel VT). It consists of a loadable kernel module, kvm.ko, that provides the core virtualization infrastructure
and a processor specific module, such as kvm-intel.ko.

FMCv Requires 28 GB RAM for Upgrade (6.6.0+)

The FMCv platform has introduced a new memory check during upgrade. FMCv upgrades to Version 6.6.0+
will fail if you allocate less than 28 GB RAM to the virtual appliance.

We recommend you do not decrease the default settings: 32 GB RAM for most FMCv instances, 64 GB for
the FMCv 300. To improve performance, you can always increase a virtual appliance’s memory and number
of CPUs, depending on your available resources.

Important

As a result of this memory check, we will not be able to support lower memory instances on supported
platforms.

Memory and Resource Requirements

You can run multiple virtual machines running unmodified OS images using KVM. Each virtual machine has
private virtualized hardware: a network card, disk, graphics adapter, and so forth. See the Cisco Firepower
Compatibility Guide for hypervisor compatibility.
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When upgrading the FMCv, check the latest Firepower Release Notes for details on whether a new release
affects your environment. You may be required to increase resources to deploy the latest version of Firepower.

Important

When you upgrade Firepower, you add the latest features and fixes that help improve the security capabilities
and performance of your Firepower deployment.

The specific hardware used for FMCv deployments can vary, depending on the number of instances deployed
and usage requirements. Each virtual appliance you create requires a minimum resource allocation—memory,
number of CPUs, and disk space—on the host machine.

The following lists the recommended and default settings for the FMCv appliance on KVM:

• Processors

• Requires 4 vCPUs

• Memory

• Minimum required 28 / Recommended (default) 32 GB RAM

The FMCv platform has introduced a new memory check during upgrade. FMCv
upgrades to Version 6.6.0+ will fail if you allocate less than 28 GB RAM to the
virtual appliance.

Important

• Networking

• Supports virtio drivers

• Supports one management interface

• Host storage per Virtual Machine

• The FMCv requires 250 GB

• Supports virtio and scsi block devices

• Console

• Supports terminal server via telnet

Prerequisites for Deployment Using KVM
• Download the Firepower Management Center Virtual qcow2 file from Cisco.com and put it on your

Linux host:

https://software.cisco.com/download/navigator.html

• A Cisco.com login and Cisco service contract are required.
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• For the purpose of the sample deployment in this document, we assume you are using Ubuntu 18.04
LTS. Install the following packages on top of the Ubuntu 18.04 LTS host:

• qemu-kvm

• libvirt-bin

• bridge-utils

• virt-manager

• virtinst

• virsh tools

• genisoimage

• Performance is affected by the host and its configuration. You can maximize the throughput on KVM
by tuning your host. For generic host-tuning concepts, see Network Function Virtualization: Quality of
Service in Broadband Remote Access Servers with Linux and Intel Architecture.

• Useful optimizations for Ubuntu 18.04 LTS include the following:

• macvtap—High performance Linux bridge; you can use macvtap instead of a Linux bridge. Note
that you must configure specific settings to use macvtap instead of the Linux bridge.

• Transparent Huge Pages—Increases memory page size and is on by default in Ubuntu 18.04.

• Hyperthread disabled—Reduces two vCPUs to one single core.

• txqueuelength—Increases the default txqueuelength to 4000 packets and reduces drop rate.

• pinning—Pins qemu and vhost processes to specific CPU cores; under certain conditions, pinning
is a significant boost to performance.

• For information on optimizing a RHEL-based distribution, see Red Hat Enterprise Linux6 Virtualization
Tuning and Optimization Guide.

Guidelines and Limitations
• Firepower Management Center Virtual appliances do not have serial numbers. The System >

Configuration page will show either None or Not Specified depending on the virtual platform.

• Nested hypervisors (KVM running on top of VMware/ESXi) are not supported. Only bare-metal KVM
deployments are supported.

• Cloning a virtual machine is not supported.

• High Availability is not supported.
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Prepare the Day 0 Configuration File
You can prepare a Day 0 configuration file before you launch the FMCv. The Day 0 configuration is a text
file that contains the initial configuration data that gets applied at the time a virtual machine is deployed. This
initial configuration is placed into a text file named “day0-config” in a working directory you chose, and is
manipulated into a day0.iso file that is mounted and read on first boot.

The day0.iso file must be available during first boot.Note

If you deploy with a Day 0 configuration file, the process allows you to perform the entire initial setup for
FMCv appliance. You can specify:

• EULA acceptance

• A host name for the system

• A new administrator password for the admin account

• Network settings that allow the appliance to communicate on your management network If you deploy
without a Day 0 configuration file, you must configure Firepower System-required settings after launch;
see Deploy Without the Day 0 Configuration File, on page 28 for more information.

We use Linux in this example, but there are similar utilities for Windows.Note

• Leave both DNS entries empty to use the default Cisco Umbrella DNS servers. To operate in a non-DNS
environment, set both entries to “None” (not case sensitive).

Step 1 Enter the CLI configuration for the FMCv network settings in a text file called “day0-config”.

Example:

#FMC
{
    "EULA": "accept",
    "Hostname": "FMC-Production",
    "AdminPassword": "Admin123",
    "DNS1": "10.1.1.5",
    "DNS2": "192.168.1.67",

    "IPv4Mode": "manual",
    "IPv4Addr": "10.12.129.45",
    "IPv4Mask": "255.255.0.0",
    "IPv4Gw": "10.12.0.1",
    "IPv6Mode": "disabled",
    "IPv6Addr": "",
    "IPv6Mask": "",
    "IPv6Gw": "",
}

Step 2 Generate the virtual CD-ROM by converting the text file to an ISO file:
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Example:

/usr/bin/genisoimage -r -o day0.iso day0-config

or

Example:

/usr/bin/mkisofs -r -o day0.iso day0-config

Step 3 Repeat to create unique default configuration files for each FMCv you want to deploy.

What to do next

• If using virt-install, add the following line to the virt-install command:

--disk path=/home/user/day0.iso,format=iso,device=cdrom \

• If using virt-manager, you can create a virtual CD-ROM using the virt-manager GUI; see Launch Using
Virtual Machine Manager, on page 25.

Launch the FMCv
You can launch the FMCv on KVM using the following methods:

• Using a Deployment Script—Use a virt-install based deployment script to launch the FMCv; see Launch
Using a Deployment Script, on page 23.

• Using Virtual Machine Manager—Use virt-manager, a graphical tool for creating and managing KVM
guest virtual machines, to launch the FMCv; see Launch Using Virtual Machine Manager, on page 25.

• Using OpenStack—Use an OpenStack environment to launch the FMCv; see Launch Using OpenStack,
on page 26.

You can also choose to deploy the FMCv without the Day 0 configuration file. This requires you to complete
the initial setup using the appliance’s CLI or the web interface.

Launch Using a Deployment Script
You can use a virt-install based deployment script to launch the Firepower Management Center Virtual.

Before you begin

Be aware that you can optimize performance by selecting the best guest caching mode for your environment.
The cache mode in use will affect whether data loss occurs, and the cache mode can also affect disk
performance.

Each KVM guest disk interface can have one of the following cache modes specified: writethrough, writeback,
none, directsync, or unsafe. The writethrough mode provides read caching; writeback provides read and write
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caching; directsync bypasses the host page cache; unsafe may cache all content and ignore flush requests from
the guest.

• A cache=writethrough will help reduce file corruption on KVM guest machines when the host experiences
abrupt losses of power. We recommend that you use writethrough mode.

• However, cache=writethrough can also affect disk performance due to more disk I/O writes than
cache=none.

• If you remove the cache parameter on the --disk option, the default is writethrough.

• Not specifying a cache option may also significantly reduce the time required for the VM creation. This
is due to the fact that some older RAID controllers have poor disk caching capability. Hence, disabling
disk caching (cache=none) and thus defaulting to writethrough, helps ensure data integrity.

Step 1 Create a virt-install script called “virt_install_fmc.sh”.

The name of the Firepower Management Center Virtual instance must be unique across all other virtual machines (VMs)
on this KVM host. The Firepower Management Center Virtual can support one network interface. The virtual NIC must
be Virtio.

Example:

virt-install \
    --connect=qemu:///system \
    --network network=default,model=virtio \
    --name=fmcv \
    --arch=x86_64 \
    --cpu host \
    --vcpus=4 \
    --ram=8192 \
    --os-type=linux \
    --virt-type=kvm \
    --import \
    --watchdog i6300esb,action=reset \
    --disk path=<fmc_filename>.qcow2,format=qcow2,device=disk,bus=virtio,cache=writethrough \
    --disk path=<day0_filename>.iso,format=iso,device=cdrom \
    --console pty,target_type=serial \
    --serial tcp,host=127.0.0.1:<port>,mode=bind,protocol=telnet \
    --force

Step 2 Run the virt_install script:

Example:

/usr/bin/virt_install_fmc.sh
Starting install...
Creating domain...

A window appears displaying the console of the VM. You can see that the VM is booting. It takes a few minutes for the
VM to boot. Once the VM stops booting you can issue CLI commands from the console screen.
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Launch Using Virtual Machine Manager
Use virt-manager, also known as Virtual Machine Manager, to launch the Firepower Management Center
Virtual. virt-manager is a graphical tool for creating and managing guest virtual machines.

Step 1 Start virt-manager (Applications > System Tools > Virtual Machine Manager).

You may be asked to select the hypervisor and/or enter your root password.

Step 2 Click the button in the top left corner to open the New VM wizard.

Step 3 Enter the virtual machine details:

a) For the operating system, select Import existing disk image.

This method allows you to import a disk image (containing a pre-installed, bootable operating system) to it.

b) Click Forward to continue.

Step 4 Load the disk image:

a) Click Browse... to select the image file.
b) Choose Use Generic for the OS type.
c) Click Forward to continue.

Step 5 Configure the memory and CPU options:

a) Set Memory (RAM) to 8192.
b) Set CPUs to 4.
c) Click Forward to continue.

Step 6 Check the Customize configuration before install box, specify a Name, then click Finish.

Doing so opens another wizard that allows you to add, remove, and configure the virtual machine's hardware settings.

Step 7 Modify the CPU configuration.

From the left panel, select Processor, then select Configuration > Copy host CPU configuration.

This applies the physical host's CPU model and configuration to your virtual machine.

Step 8 8. Configure the Virtual Disk:

a) From the left panel, select Disk 1.
b) Select Advanced options.
c) Set the Disk bus to Virtio.
d) Set the Storage format to qcow2.

Step 9 Configure a serial console:

a) From the left panel, select Console.
b) Select Remove to remove the default console.
c) Click Add Hardware to add a serial device.
d) For Device Type, select TCP net console (tcp).
e) For Mode, select Server mode (bind).
f) For Host, enter 0.0.0.0 for the IP address and enter a unique Port number.
g) Check the Use Telnet box.
h) Configure device parameters.
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Step 10 Configure a watchdog device to automatically trigger some action when the KVM guest hangs or crashes:

a) Click Add Hardware to add a watchdog device.
b) For Model, select default.
c) For Action, select Forcefully reset the guest.

Step 11 Configure the virtual network interface.

Choose macvtap or specify a shared device name (use a bridge name).

By default, the Firepower Management Center Virtual virtual instance launches with one interface, which
you can then configure.

Note

Step 12 If deploying using a Day 0 configuration file, create a virtual CD-ROM for the ISO:

a) Click Add Hardware.
b) Select Storage.
c) Click Select managed or other existing storage and browse to the location of the ISO file.
d) For Device type, select IDE CDROM.

Step 13 After configuring the virtual machine's hardware, click Apply.

Step 14 Click Begin installation for virt-manager to create the virtual machine with your specified hardware settings.

Launch Using OpenStack
You can deploy the Firepower Management Center Virtual in an OpenStack environment. OpenStack is a set
of software tools for building and managing cloud computing platforms for public and private clouds, and is
tightly integrated with the KVM hypervisor.

About the Day 0 Configuration File on OpenStack

OpenStack supports providing configuration data via a special configuration drive (config-drive) that is
attached to the instance when it boots. To deploy a Firepower Management Center Virtual instance with Day
0 configuration using the nova boot command, include the following line:

    --config-drive true --file day0-config=/home/user/day0-config \ 

When the --config-drive command is enabled, the file =/home/user/day0-config, as found on the Linux
filesystem where the nova client is invoked, is passed to the virtual machine on a virtual CDROM.

While the VM may see this file with the name day0-config, OpenStack typically stores the file contents as
/openstack/content/xxxx where xxxx is an assigned four-digit number (e.g. /openstack/content/0000). This
may vary by OpenStack distribution.

Note

Launch on OpenStack Using the Command Line
Use the nova boot command to create and boot a FMCv instance.
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Procedure

PurposeCommand or Action

The FMCv requires one management interface.Boot a FMCv instance using image, flavor, interface and
Day 0 configuration information.

Step 1

Example:

local@maas:~$ nova boot \
    --image=6883ee2e-62b1-4ad7-b4c6-cd62ee73d1aa 
\
    --flavor=a6541d78-0bb3-4dc3-97c2-7b87f886b1ba
 \
    --nic 
net-id=5bf6b1a9-c871-41d3-82a3-2ecee26840b1 \
    --config-drive true --file 
day0-config=/home/local/day0-config \

Launch on OpenStack Using the Dashboard
Horizon is an OpenStack Dashboard, which provides a web based user interface to OpenStack services
including Nova, Swift, Keystone, and so forth.

Before you begin

• Download the FMCv qcow2 file from Cisco.com and put it on your local MAAS server:

https://software.cisco.com/download/navigator.html

• A Cisco.com login and Cisco service contract are required.

Step 1 On the Log In page, enter your user name and password, and click Sign In.

The visible tabs and functions in the dashboard depend on the access permissions, or roles, of the user you are logged
in as.

Step 2 Choose Admin > System Panel > Flavor from the menu.

Virtual hardware templates are called flavors in OpenStack, and define sizes for RAM, disk, number of cores, and so
on.

Step 3 Enter the required information in the Flavor Info window:

a) Name—Enter a descriptive name that easily identifies the instance. For example, FMC-4vCPU-8GB.
b) VCPUs—Select 4.
c) RAM MB—Select 8192.

Step 4 Choose Create Flavor.

Step 5 Choose Admin > System Panel > Images from the menu.

Step 6 Enter the required information in the Create An Image window:

a) Name—Enter a name that easily identifies the image. For example, FMC-Version-Build.
b) Description—(Optional) Enter a description for this image file.
c) Browse—Select the Firepower Management Center Virtual qcow2 file previously downloaded from Cisco.com.
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d) Format—Select QCOW2-QEMU Emulator as the format type.
e) Check the Public box.

Step 7 Choose Create Image.

View the newly created Image.

Step 8 Choose Project > Compute > Instances from the menu.

Step 9 Click Launch Instance.

Step 10 Enter the required information in the Launch Instance > Details tab:

a) Instance Name—Enter a name that easily identifies the instance. For example, FMC-Version-Build.
b) Flavor—Select the flavor created earlier in Step 3. Enter a description for this image file.
c) Instance Boot Source—Select Boot from image.
d) Image Name—Select the image created earlier in Step 6.

Step 11 From the Launch Instance > Networking tab, select a management network for the Firepower Management Center
Virtual instance.

Step 12 Click Launch.

The instance starts on a compute node in the cloud. View the newly created instance from the Instances window.

Step 13 Select the Firepower Management Center Virtual instance.

Step 14 Select the Console tab.

Step 15 Log into the virtual appliance at the console.

Deploy Without the Day 0 Configuration File
For all Firepower Management Centers, you must complete a setup process that allows the appliance to
communicate on your management network. If you deploy without a Day 0 configuration file, setting up a
FMCv is a two-step process:

• After you initialize the FMCv, run a script at the appliance console that helps you configure the appliance
to communicate on your management network.

• Then, complete the setup process using a computer on your management network to browse to the web
interface of the FMCv.

Configure Network Settings Using a Script
The following procedure describes how you complete the initial setup on a FMCv using the CLI.

Step 1 At the console, log into the FMCv appliance. Use admin as the username and Admin123 as the password.

Step 2 At the admin prompt, run the following script:

Example:
sudo /usr/local/sf/bin/configure-network

On first connection to the FMCv you are prompted for post-boot configuration.
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Step 3 Follow the script’s prompts.

Configure (or disable) IPv4 management settings first, then IPv6. If you manually specify network settings, you must
enter IPv4 or IPv6 addresses.

Step 4 Confirm that your settings are correct.

Step 5 Log out of the appliance.

What to do next

• Complete the setup process using a computer on your management network to browse to the web interface
of the FMCv.

Perform Initial Setup Using the Web Interface
The following procedure describes how you complete the initial setup on a FMCv using the web interface.

Step 1 Direct your browser to default IP address of the FMCv’s management interface:

Example:
https://192.168.45.45

Step 2 Log into the Firepower Management Center Virtual appliance. Use admin as the username and Admin123 as the password.
The setup page appears.

The setup page appears. You must change the administrator password, specify network settings if you haven’t already,
and accept the EULA.

Step 3 When you are finished, click Apply. The FMCv is configured according to your selections. After an intermediate page
appears, you are logged into the web interface as the admin user, which has the Administrator role.

The FMCv is configured according to your selections. After an intermediate page appears, you are logged into the web
interface as the admin user, which has the Administrator role.

What to do next

• For more information about the initial setup of the FMCv, see Firepower Management Center Virtual
Initial Setup, on page 97

• For an overview of the next steps needed in your FMCv deployment, see the chapter Firepower
Management Center Virtual Initial Administration and Configuration, on page 105.
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C H A P T E R 4
Deploy the Firepower Management Center Virtual
On the AWS Cloud

Amazon Virtual Private Cloud (Amazon VPC) enables you to launch Amazon Web Services (AWS) resources
into a virtual network that you define. This virtual network closely resembles a traditional network that might
operate in your own data center, with the benefits of using the scalable infrastructure of AWS.

You can deploy the Firepower Management Center Virtual (FMCv) on the AWS Cloud.

• About FMCv Deployment and AWS, on page 31
• Guidelines and Limitations for AWS Deployment, on page 33
• Configure the AWS Environment, on page 34
• Deploy the Firepower Management Center Virtual Instance, on page 39

About FMCv Deployment and AWS
FMCv Requires 28 GB RAM for Upgrade (6.6.0+)

The FMCv platform has introduced a new memory check during upgrade. FMCv upgrades to Version 6.6.0+
will fail if you allocate less than 28 GB RAM to the virtual appliance.

As of the Version 6.6.0 release, lower-memory instance types for cloud-based FMCv deployments (AWS,
Azure) are fully deprecated. You cannot create new FMCv instances using them, even for earlier Firepower
versions. You can continue running existing instances. See Table 6: AWS Supported Instances for FMCv, on
page 32.

Important

As a result of this memory check, we will not be able to support lower memory instances on supported
platforms.

The following table summarizes the AWS instances types that FMCv supports; those that Versions 6.5.x and
earlier support, and those that Version 6.6.0+ support.
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Firepower Version 6.6 adds support for the C5 instance types shown in the following table. Larger instance
types provide more CPU resources to your AWS VMs for increased performance, and some allow for more
network interfaces.

Note

Table 6: AWS Supported Instances for FMCv

Version 6.5.x and earlier*Version 6.6.0+Platform

c3.xlarge: 4 vCPUs, 7.5 GBc3.4xlarge: 16 vCPUs, 30 GB

FMCv

c3.2xlarge: 8 vCPUs, 15 GBc4.4xlarge: 16 vCPUs, 30 GB

c4.xlarge: 4 vCPUs, 7.5 GBc5.4xlarge: 16 vCPUs, 32 GB

c4.2xlarge: 8 vCPUs, 15 GB—

*Note that FMCv will no longer support these instance types after Version 6.6.0 is
released. Beginning with Version 6.6.0, you must deploy the FMCv (any version)
using an instance with at least 28 GB RAM. See Resizing Instances, on page 32.

Table 7: AWS Supported Instances for FMCv 300

Version 7.1.0+Platform

c5.9xlarge: 36 vCPUs, 72 GB

SSD storage: 2000 GB

FMCv 300

Deprecated Instances

You can continue running your current Version 6.5.x and earlier FMCv deployments, but you will not be able
to launch new FMCv deployments (any version) using these instances:

• c3.xlarge—4 vCPUs, 7.5 GB (DISABLED for FMCv after Version 6.6.0+)

• c3.2xlarge—8 vCPUs, 15 GB (DISABLED for FMCv after Version 6.6.0+)

• c4.xlarge—4 vCPUs, 7.5 GB (DISABLED for FMCv after Version 6.6.0+)

• c4.2xlarge—8 vCPUs, 15 GB (DISABLED for FMCv after Version 6.6.0+)

Resizing Instances

Because the upgrade path from any earlier version of FMCv (6.2.x, 6.3.x, 6.4.x, and 6.5.x) to Version 6.6.0
includes the 28 GB RAM memory check, you need to resize your current instance type to one that supports
Version 6.6.0 (see Table 6: AWS Supported Instances for FMCv, on page 32).

You can resize an instance if the current instance type and the new instance type that you want are compatible.
For FMCv deployments:

• Resize any c3.xlarge or c3.2xlarge to the c3.4xlarge instance type.

• Resize any c4.xlarge or c4.2xlarge to the c4.4xlarge instance type.
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Be aware of the following before resizing your instance:

• You must stop your instance before you change instance types.

• Verify that your current instance type is compatible with the new instance type that you choose.

• If this instance has an instance store volume, any data on it is lost when the instance is stopped. Migrate
your instance store-backed instance before you resize.

• If you're not using an Elastic IP address, the public IP address is released when you stop the instance.

For instructions on how to resize your instance, see the AWS documentation “Changing the Instance Type”
(https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/ec2-instance-resize.html).

AWS Solution Overview
AWS is a collection of remote computing services offered by Amazon.com, also called web services, that
make up a cloud-computing platform. These services operate from 11 geographical regions across the world.
In general, you should become familiar with the following AWS services when deploying the FMCv:

• Amazon Elastic Compute Cloud (EC2)—a web service that enables you to rent virtual computers to
launch and manage your own applications and service, such as a firewall, in Amazon's data centers.

• Amazon Virtual Private Cloud (VPC)—a web service that enables you to configure an isolated private
network that exists within the Amazon public cloud. You run you EC2 instances within a VPC.

• Amazon Simple Storage Service (S3)—a web service that provides you with a data storage infrastructure.

You create an account on AWS, set up the VPC and EC2 components (using either the AWS Wizards or
manual configuration), and chose an Amazon Machine Image (AMI) instance. The AMI is a template that
contains the software configuration needed to launch your instance.

The AMI images are not available for download outside of the AWS environment.Note

Guidelines and Limitations for AWS Deployment
Supported Features (7.1.0+)

• FMCv 300 for AWS—A new scaled FMCv image is available on the AWS platform that supports
managing up to 300 devices and has higher disk capacity.

• FMCv high availability (HA) is supported on both FMCv models: FMCv and FMCv 300.

Prerequisites

The following prerequisites pertain to the FMCv on AWS:

• An Amazon account. You can create one at aws.amazon.com.

• A Cisco Smart Account. You can create one at Cisco Software Central (https://software.cisco.com/).
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• License the FMCv. See Firepower Management Center Virtual Licenses, on page 3 for general guidelines
about virtual platform licenses; see “Licensing the Firepower System” in the Firepower Management
Center Configuration Guide for more detailed information about how to manage licenses.

• FMCv interface requirements:

• Management interface.

• Communication Paths:

• Public/elastic IPs for access into the FMCv.

• For FMCv and Firepower System compatibility, see the Cisco Firepower Compatibility Guide.

Guidelines

The following guidelines pertain to the FMCv on AWS:

• Deployment in the Virtual Private Cloud (VPC).

• Enhanced networking (SR-IOV) where available.

• Deployment from Amazon Marketplace.

• Maximum of four vCPUs per instance.

• User deployment of L3 networks.

Limitations

The following limitations pertain to the FMCv on AWS:

• Cisco Firepower Management Center Virtual appliances do not have serial numbers. The System >
Configuration page will show either None or Not Specified depending on the virtual platform.

• Any IP address configuration (either from CLI or Firepower Management Center) must match what is
created in the AWS console; you should note your configurations during deployment.

• IPv6 is not currently supported.

• You cannot add interfaces after boot.

• Cloning/snapshots are currently not supported.

Configure the AWS Environment
To deploy FMCv on AWS you need to configure an Amazon VPC with your deployment-specific requirements
and settings. In most situations a setup wizard can guide you through your setup. AWS provides online
documentation where you can find useful information about the services ranging from introductions to advanced
features. See Getting Started with AWS for more information.

For greater control over your AWS setup, the following sections offer a guide to your VPC and EC2
configurations prior to launching instances of the FMCv:

• Create the VPC, on page 35
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• Add the Internet Gateway, on page 36

• Add Subnets, on page 36

• Add a Route Table, on page 37

• Create a Security Group, on page 37

• Create Network Interfaces, on page 38

• Create Elastic IPs, on page 38

Create the VPC
A virtual private cloud (VPC) is a virtual network dedicated to your AWS account. It is logically isolated
from other virtual networks in the AWS cloud. You can launch your AWS resources, such as Firepower
Management Center Virtual instances, into your VPC. You can configure your VPC; you can select its IP
address range, create subnets, and configure route tables, network gateways, and security settings.

Before you begin

• Create your AWS account.

• Confirm that AMIs are available for Firepower Management Center Virtual instances.

Step 1 Log into aws.amazon.com and choose your region.

AWS is divided into multiple regions that are isolated from each other. The region is displayed in the upper right corner
of your screen. Resources in one region do not appear in another region. Check periodically to make sure you are in the
intended region.

Step 2 Click Services > VPC.

Step 3 Click VPC Dashboard > Your VPCs.

Step 4 Click Create VPC.

Step 5 Enter the following in the Create VPC dialog box:

a) A user-defined Name tag to identify the VPC.
b) A CIDR block of IP addresses. CIDR (Classless Inter-Domain Routing) notation is a compact representation of an

IP address and its associated routing prefix. For example, 10.0.0.0/24.
c) A Tenancy setting of Default to ensure that instances launched in this VPC use the tenancy attribute specified at

launch.

Step 6 Click Yes, Create to create your VPC.

What to do next

Add an Internet gateway to your VPC as described in the next section.
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Add the Internet Gateway
You can add an Internet gateway to connect your VPC to the Internet. You can route traffic for IP addresses
outside your VPC to the Internet gateway.

Before you begin

• Create a VPC for your FMCv instances.

Step 1 Click Services > VPC.

Step 2 Click VPC Dashboard > Internet Gateways, and then click Create Internet Gateway.

Step 3 Enter a user-defined Name tag to identify the gateway and click Yes, Create to create the gateway.

Step 4 Select the gateway created in the previous step.

Step 5 Click Attach to VPC and select the VPC you created previously.

Step 6 Click Yes, Attach to attach the gateway to your VPC.

By default, the instances launched on the VPC cannot communicate with the Internet until a gateway is created and
attached to the VPC.

What to do next

Add subnets to your VPC as described in the next section.

Add Subnets
You can segment the IP address range of your VPC that Firepower Management Center Virtual instances can
be attached to. You can create subnets to group instances according to security and operational needs. For
Firepower Threat Defense Virtual you need to create a subnet for management as well as subnets for traffic.

Step 1 Click Services > VPC.

Step 2 Click VPC Dashboard > Subnets, and then click Create Subnet.

Step 3 Enter the following in the Create Subnet dialog box:

a) A user-defined Name tag to identify the subnet.
b) A VPC to use for this subnet.
c) The Availability Zone where this subnet will reside. Select No Preference to let Amazon select the zone.
d) A CIDR block of IP addresses. The range of IP addresses in the subnet must be a subset of the range of IP addresses

in the VPC. Block sizes must be between a /16 network mask and a /28 network mask. The size of the subnet can
equal the size of the VPC.

Step 4 Click Yes, Create to create your subnet.

Step 5 Repeat for as many subnets required. Create a separate subnet for management traffic and create as many subnets as
needed for data traffic.
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What to do next

Add a route table to your VPC as described in the next section.

Add a Route Table
You can attach a route table to the gateway you configured for your VPC. You can also associate multiple
subnets with a single route table, but a subnet can be associated with only one route table at a time.

Step 1 Click Services > VPC.

Step 2 Click VPC Dashboard > Route Tables, and then click Create Route Table.

Step 3 Enter a user-defined Name tag to identify the route table.

Step 4 Select the VPC from the drop-down list that will use this route table.

Step 5 Click Yes, Create to create your route table.

Step 6 Select the route table that you just created.

Step 7 Click the Routes tab to display the route information in the details pane.

Step 8 Click Edit, then click Add another route.

a) In the Destination column, enter 0.0.0.0/0.
b) In the Target column, select the Internet Gateway you created above.

Step 9 Click Save.

Step 10 Click the Subnet Associations tab and click Edit.

Step 11 Check the box next to the subnet to be used for the FMCv's management interface and click Save.

What to do next

Create a security group as described in the next section.

Create a Security Group
You can create a security group with rules specifying allowed protocols, ports and source IP ranges. Multiple
security groups can be created with different rules which you can assign to each instance. AWS has detailed
documentation on Security Groups if you are not familiar with this feature.

Step 1 Click Services > EC2.

Step 2 Click EC2 Dashboard > Security Groups.

Step 3 Click Create Security Group.

Step 4 Enter the following in the Create Security Group dialog box:

a) A user-defined Security group name to identify the security group.
b) A Description for this security group.
c) The VPC associated with this security group.

Step 5 Configure Security group rules:

a) Click the Inbound tab, then click Add Rule.
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HTTPS and SSH access is required to manage the FMCv from outside AWS. You should specify the Source
IP addresses accordingly. Also, if you are configuring both FMCv and FTDv within the AWS VPC, you
should allow the private IP management subnet access.

Note

b) Click the Outbound tab, then click Add Rule to add a rule for outbound traffic, or leave the defaults of All traffic
(for Type) and Anywhere (for Destination).

Step 6 Click Create to create your security group.

What to do next

Create network interfaces as described in the next section.

Create Network Interfaces
You can create network interfaces for the FMCv using static IP addresses. Create network interfaces (external
and internal) as needed for your particular deployment.

Step 1 Click Services > EC2.

Step 2 Click EC2 Dashboard > Network Interfaces.

Step 3 Click Create Network Interface.

Step 4 Enter the following in the Create Network Interface dialog box:

a) A optional user-defined Description for the network interface.
b) Select a Subnet from the drop-down list. Make sure to select the subnet of the VPC where you want to create the

Firepower instance.
c) Enter a Private IP address. It is recommended to use a static IP address rather than auto-assign.
d) Select one or more Security groups. Make sure the security group has all the required ports open.

Step 5 Click Yes, Create to create your network interface.

Step 6 Select the network interface that you just created.

Step 7 Right-click and select Change Source/Dest. Check.

Step 8 Choose Disabled, then click Save.

Repeat this for any network interfaces you create.

What to do next

Create elastic IP addresses as described in the next section.

Create Elastic IPs
When an instance is created, a public IP address is associated with the instance. That public IP address changes
automatically when you STOP and START the instance. To resolve this issue, assign a persistent public IP
address to the instance using Elastic IP addressing. Elastic IPs are reserved public IPs that are used for remote

Cisco Firepower Management Center Virtual Getting Started Guide
38

Deploy the Firepower Management Center Virtual On the AWS Cloud
Create Network Interfaces



access to the FMCv as well as other instances. AWS has detailed documentation on Elastic IPs if you are not
familiar with this feature.

At a minimum, you want to create one elastic IP addresses for the FMCv and two elastic IP addresses for the
Firepower Threat Defense Virtual management and diagnostic interfaces.

Note

Step 1 Click Services > EC2.

Step 2 Click EC2 Dashboard > Elastic IPs.

Step 3 Click Allocate New Address.

Repeat this step for as many elastic/public IPs that you require.

Step 4 Click Yes, Allocate to create your elastic IP.

Step 5 Repeat for as many elastic IPs required for your deployment.

What to do next

Deploy the FMCv as described in the next section.

Deploy the Firepower Management Center Virtual Instance
Before you begin

• Configure AWS VPC and EC2 elements as described in Configure the AWS Environment.

• Confirm that an AMI is available for FMCv instances.

The default admin password is the AWS Instance ID, unless you define a default password with user data
(Advanced Details > User Data) during the initial deployment.

Note

Step 1 Go to https://aws.amazon.com/marketplace (Amazon Marketplace) and sign in.

Step 2 After you are logged in to the Amazon Marketplace, click the link provided for Firepower Management Center Virtual.

If you were previously in AWS, you may need to sign out and then sign back in for the link to work.Note

Step 3 Click Continue, then click the Manual Launch tab.

Step 4 Click Accept Terms.

Step 5 Click Launch with EC2 Console in your desired region

Step 6 Choose an Instance Type supported by the Firepower Management Center Virtual; see About FMCv Deployment and
AWS for the supported instance types.
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Step 7 Click the Next: Configure Instance Details button at the bottom of the screen:

a) Change the Network to match your previously created VPC.
b) Change the Subnet to match your previously created management subnet. You can specify an IP address or use

auto-generate.
c) Under Advanced Details > User Data, add the default login information.

Modify the example below to match your requirements for device name and password.

Sample login configuration:

#FMC
{
"AdminPassword": "<enter_your_password>",
"Hostname": "<Hostname-vFMC>"
}

Use only plain text when entering data in the Advanced Details field. If you copy this information from
a text editor, make sure you copy only as plain text. If you copy any Unicode data into the Advanced
Details field, including white space, the instance may be corrupted and you will have to terminate the
instance and re-create it.

Caution

In Version 7.0 and greater, the default admin password is the AWS Instance ID, unless you define a default password
with user data (Advanced Details > User Data) during the initial deployment.

In earlier releases the default admin password was Admin123.

Step 8 Click Next: Add Storage to configure your storage device settings.

Edit the settings of the root volume so the volume Size (GiB) is 250 GiB. Less than 250 GiB will limit event storage
and is not supported.

Step 9 Click Next: Tag Instance.

A tag consists of a case-sensitive key-value pair. For example, you could define a tag with Key = Name and Value =
Management.

Step 10 Select Next: Configure Security Group.

Step 11 Click Select an existing Security Group and choose the previously configured Security Group, or create a new Security
Group; see AWS documentation for more information on creating Security Groups.

Step 12 Click Review and Launch.

Step 13 Click Launch.

Step 14 Select an existing key pair or create a new key pair.

You can select an existing key pair, or create a new key pair. The key pair consists of a public key that AWS
stores and a private key file that the user stores. Together they allow you to connect to your instance securely.
Be sure to save the key pair to a known location, as it will may be required to connect to the instance.

Note

Step 15 Click Launch Instances.

Step 16 Click EC2 Dashboard > Elastic IPs and find a previously allocated IP, or allocate a new one.

Step 17 Select the elastic IP, right-click and select Associate Address.

Locate the Instance or Network Interface to select, then click Associate.

Step 18 Click EC2 Dashboard > Instances.
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Step 19 The FMCv Instance state will show “running” and Status checks will show pass for “2/2 checks” after only a few
minutes. However, deployment and initial setup processes will take approximately 30 to 40 minutes to complete. To
view the status, right-click the Instance, then select Instance Settings > Get Instance Screenshot.

When setup is complete (after approximately 30 to 40 minutes), the Instance Screenshot should show a message
similar to “Cisco Firepower Management Center for AWS vW.X.Y (build ZZ)” and possibly followed by some additional
lines of output.

You should then be able to log in to the newly created FMCv using SSH or HTTPs. Actual deployment times may vary
depending on the AWS load in your region.

You can access the FMCv using SSH:

ssh -i <key_pair>.pem admin@<Public_Elastic_IP>

SSH authentication is handled by a key pair. No password is required. If you are prompted for a password then setup
is still running.

You can also access the FMCv using HTTPS:

https//<Public_Elastic_IP>

If you see a “system startup processes are still running” then setup is not yet complete.Note

If you get no response from SSH or HTTPS, double check these items:

• Make sure deployment is complete. The FMCv VM Instance Screenshot should show a message similar to “Cisco
Firepower Management Center for AWS vW.X.Y (build ZZ)” and possibly followed by some additional lines of
output.

• Make sure you have an Elastic IP and that it is associated with the Firepower Management Center's management
network interface (eni) and that you are connecting to that IP address.

• Make sure there is an Internet Gateway (igw) associated with your VPC.

• Make sure your management subnet has a route table associated with it.

• Make sure the route table associated with your Management subnet has a route for “0.0.0.0/0” that points to your
Internet gateway (igw).

• Make sure your Security Group allows incoming SSH and/or HTTPS from the IP addresses you are connecting
from.

What to do next

Configuring Policies and Device Settings

After you install Firepower Threat Defense Virtual and add the device to the Management Center, you can
use the Firepower Management Center user interface to configure device management settings for Firepower
Threat Defense Virtual running on AWS and to configure and apply access control policies and other related
policies to manage traffic using your Firepower Threat Defense Virtual device. The security policy controls
the services provided by the Firepower Threat Defense Virtual, such as Next Generation IPS filtering and
application filtering. You configure the security policy on the Firepower Threat Defense Virtual using the
Firepower Management Center. For information about how to configure the security policy, see the Firepower
Configuration Guide or the online help in Firepower Management Center.
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C H A P T E R 5
Deploy the Firepower Management Center Virtual
On the Microsoft Azure Cloud

You can deploy the Firepower Management Center Virtual (FMCv) as a virtual machine on the Microsoft
Azure public cloud.

The FMCv is supported on Microsoft Azure starting with Cisco Firepower software version 6.4 and later.Important

• About FMCv Deployment and Azure, on page 43
• Prerequisites and System Requirements, on page 44
• Guidelines and Limitations, on page 45
• Resources Created During Deployment, on page 46
• Deploy the Firepower Management Center Virtual, on page 47
• Verify the Firepower Management Center Virtual Deployment, on page 50
• Monitoring and Troubleshooting, on page 52
• History for FMCv On the Microsoft Azure Cloud, on page 53

About FMCv Deployment and Azure
You deploy the Firepower Management Center Virtual (FMCv) in Microsoft Azure using a solution template
available in the Azure Marketplace. When you deploy the FMCv using the Azure portal you can use an existing
empty resource group and storage account (or create them new). The solution template walks you through a
set of configuration parameters that provide the initial setup of your FMCv, allowing you to login to the FMCv
web interface after first boot.

FMCv Requires 28 GB RAM for Upgrade (6.6.0+)

The FMCv platform has introduced a new memory check during upgrade. FMCv upgrades to Version 6.6.0+
will fail if you allocate less than 28 GB RAM to the virtual appliance.
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As of the Version 6.6.0 release, lower-memory instance types for cloud-based FMCv deployments (AWS,
Azure) are fully deprecated. You cannot create new FMCv instances using them, even for earlier Firepower
versions. You can continue running existing instances. See Table 8: Azure Supported Instances for FMCv,
on page 44.

Important

As a result of this memory check, we will not be able to support lower memory instances on supported
platforms.

The FMCv on Azure must be deployed in a virtual network (VNet) using the Resource Manager deployment
mode. You can deploy the FMCv in the standard Azure public cloud environment. The FMCv in the Azure
Marketplace supports the Bring Your Own License (BYOL) model.

The following table summarizes the Azure instances types that FMCv supports; those that Versions 6.5.x and
earlier support, and those that Version 6.6.0+ support.

Table 8: Azure Supported Instances for FMCv

Version 6.5.x and earlier*Version 6.6.0+Platform

Standard_D3_v2: 4 vCPUs, 14 GBStandard_D4_v2: 8 vCPUs, 28 GB

FMCv

Standard_D4_v2: 8 vCPUs, 28 GB—

*Note that FMCv will no longer support the Standard_D3_v2 instance after Version
6.6.0 is released. Beginning with Version 6.6.0, you must deploy the FMCv (any
version) using an instance with at least 28 GB RAM. See Resizing Instances, on page
44.

Deprecated Instances

You can continue running your current Version 6.5.x and earlier FMCv deployments using Standard_D3_v2,
but you will not be able to launch new FMCv deployments (any version) using this instance.

Resizing Instances

Because the upgrade path from any earlier version of FMCv (6.2.x, 6.3.x, 6.4.x, and 6.5.x) to Version 6.6.0
includes the 28 GB RAM memory check, if you are using the Standard_D3_v2, you need to resize your
instance type to Standard_D4_v2 (see Table 8: Azure Supported Instances for FMCv, on page 44).

You can use the Azure portal or PowerShell to resize your instance. If the virtual machine is currently running,
changing its size will cause it to be restarted. Stopping the virtual machine may reveal additional sizes.

For instructions on how to resize your instance, see the Azure documentation “Resize a Windows VM”
(https://docs.microsoft.com/en-us/azure/virtual-machines/windows/resize-vm).

Prerequisites and System Requirements
Support for the FMCv on Microsoft Azure is new with the release of Firepower version 6.4.0. For Firepower
Management Center Virtual and Firepower System compatibility, see Cisco Firepower Threat Defense Virtual
Compatibility.
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Verify the following before you deploy the FMCv in Azure:

• Create an account on Azure.com.

After you create an account on Microsoft Azure, you can log in, search the marketplace for Cisco
Firepower Management Center Virtual, and choose the “Cisco Firepower Management Center (FMCv)
BYOL” offering.

• A Cisco Smart Account. You can create one at Cisco Software Central (https://software.cisco.com/).

Guidelines and Limitations
Supported Features

• Supported Azure Instances

• Standard D3_v2—4 vCPUs, 14GB memory, 250GB disk size

• Standard D4_v2—8 vCPUs, 28GB memory, 400GB disk size

• Public IP addressing

• The Management 0/0 is assigned a public IP address.

Licensing

The FMCv in the Azure public marketplace supports the Bring Your Own License (BYOL) model. For the
FMCv, this is a platform license rather than a feature license. The version of virtual license you purchase
determines the number of devices you can manage via the Firepower Management Center Virtual. For example,
you can purchase licenses that enable you to manage two devices, 10 devices, or 25 devices.

• Licensing modes:

• Smart License only

For licensing details, see Licensing the Firepower System in the Firepower Management Center Configuration
Guide for more information about how to manage licenses; see Cisco Firepower System Feature Licenses for
an overview of feature licenses for the Firepower System, including helpful links.

System Shut Down and Restart

Do not use the Restart and Stop controls on the Azure Virtual machine overview page to power on the FMCv
VM. These are not graceful shutdown mechanisms and can lead to database corruption.

Use the System > Configuration options available from the FMCv's Web interface to shut down or restart
the virtual appliance.

Use the shutdown and restart commands from the FMCv's command line interface to shut down or restart
the appliance.

Unsupported Features

• Licensing modes:
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• Pay As You Go (PAYG) licensing.

• Permanent License Reservation (PLR).

• Management

• Azure portal “reset password” function.

• Console-based password recovery; because the user does not have real-time access to the console,
password recovery is not possible. It is not possible to boot the password recovery image. The only
recourse is to deploy a new FMCv VM.

• High Availability (active/standby)

• VM import/export

Resources Created During Deployment
When you deploy the FMCv in Azure the following resources are created:

• A Cisco FMCv Virtual Machine (VM) with a single interface (requires a new or an existing virtual
network with 1 subnet).

• A Resource Group.

The FMCv is always deployed into a new Resource Group. However, you can attach it to an existing
Virtual Network in another Resource Group.

• A security group named vm name-mgmt-SecurityGroup.

The security group will be attached to the VM’s Nic0.

The security group includes rules to allow SSH (TCP port 22) and the management traffic for the Firepower
Management Center interface (TCP port 8305). You can modify these values after deployment.

• A Public IP Address (named according to the value you chose during deployment).

The public IP address is associated with VM Nic0, which maps to Management.

You can create a new public IP or choose an existing one. You can also choose
NONE. Without a public IP address, any communication to the FMCv must
originate within the Azure virtual network

Note

• A Routing Table for the subnet (updated if it already exists).

• A boot diagnostics file in the selected storage account.

The boot diagnostics file will be in Blobs (binary large objects).

• Two files in the selected storage account under Blobs and container VHDs named VM name-disk.vhd
and VM name-<uuid>.status.

• A Storage account (unless you chose an existing storage account).
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When you delete a VM, you must delete each of these resources individually,
except for any resources you want to keep.

Important

Deploy the Firepower Management Center Virtual
You can deploy the Firepower Management Center Virtual in Azure using templates. Cisco provides two
kinds of templates:

• Solution Template in the Azure Marketplace—Use the solution template available in the Azure
Marketplace to deploy the FMCv using the Azure portal. You can use an existing resource group and
storage account (or create them new) to deploy the virtual appliance. To use the solution template, see
Deploy from Azure Marketplace Using the Solution Template, on page 47.

• ARM Templates in the GitHub Repository—In addition to the Marketplace-based deployment, Cisco
provides Azure Resource Manager (ARM) templates in the GitHub Repository to simplify the process
of deploying the FMCv on Azure. Using a Managed Image and two JSON files (a Template file and a
Parameter file), you can deploy and provision all the resources for the FMCv in a single, coordinated
operation.

Deploy from Azure Marketplace Using the Solution Template
Deploy the Firepower Management Center Virtual (FMCv) from the Azure portal using the solution template
available in the Azure Marketplace. The following procedure is a top-level list of steps to set up the FMCv
in the Microsoft Azure environment. For detailed steps for Azure setup, see Getting Started with Azure.

When you deploy the FMCv in Azure it automatically generates various configurations, such as resources,
public IP addresses, and route tables. You can further manage these configurations after deployment. For
example, you may want to change the Idle Timeout value from the default, which is a low timeout.

Step 1 Log in to the Azure portal (https://portal.azure.com) using your Microsoft account credentials.

The Azure portal shows virtual elements associated with the current account and subscription regardless of data center
location.

Step 2 Click Create a Resource.

Step 3 Search the Marketplace for “Cisco Firepower Management Center (FMCv)”, choose the offering, and click Create.

Step 4 Configure the settings under Basics:

a) Enter a name for the virtual machine in the FMC VM name in Azure field. This name should be unique within your
Azure subscription.

Make sure you do not use an existing name or the deployment will fail.Attention

b) (Optional) Choose the FMC Software Version from the dropdown list.

This should default to the latest available version.

c) Enter a username for the Azure account administrator in the Username for primary account field.
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The name “admin” is reserved in Azure and cannot be used.

The username entered here is for the Azure account, not for FMCv administrator access. Do not use this
username to log in to the FMCv.

Attention

d) Choose an authentication type, either Password or SSH public key.

If you choose Password, enter a password and confirm. The password must be between 12 and 72 characters, and
must have 3 of the following: 1 lower case character, 1 upper case character, 1 number, and 1 special character that
is not ‘\’ or ‘-’.

If you choose SSH public key, specify the RSA public key of the remote peer.

e) Enter an FMC Hostname for the FMCv.
f) Enter an Admin Password.

This is the password you'll use when you log in to the FMCv's Web interface as the administrator to configure the
FMCv.

g) Choose your Subscription type.

Normally there is only one option listed.

h) Create a new Resource group.

The FMCv should be deployed into a new Resource Group. The option to deploy into an existing Resource Group
only works if that existing Resource Group is empty.

However, you can attach the FMCv to an existing Virtual Network in another Resource Group when configuring the
network options in later steps.

i) Select your geographical Location.

You should use the same location for all resources used in this deployment. The FMCv, the network, storage accounts,
etc. should all use the same location.

j) Click OK.

Step 5 Next, complete the initial configuration under Cisco FMCv Settings:

a) Confirm the selected Virtual machine size, or click the Change size link to view the VM size options. Click Select
to confirm..

Only the supported virtual machine sizes are shown.

b) Configure a Storage account. You can use an existing storage account or create a new one.

• Enter a Name for the storage account, then click OK. The storage account name can only contain lowercase
letters and numbers. It cannot contain special characters.

• As of this release the FMCv only supports general purpose, standard performance storage.

c) Configure a Public IP address. You can use an existing IP or create a new one.

• Click Create new to create a new public IP address. Enter a label for the IP address in the Name field, select
Standard for the SKU option, then click OK.

Azure creates a dynamic public IP address, regardless of the dynamic/static choice made in this step.
The public IP may change when the VM is stopped and restarted. If you prefer a fixed IP address, you
can edit the public-ip and change it from a dynamic to a static address after the deployment has
completed.

Note
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• You can choose NONE if you don't want to assign a public IP address to the FMCv. Without a public IP address,
any communication to the FMCv must originate within the Azure virtual network.

d) Add a DNS label that matches the label of the public IP.

The fully qualified domain name will be your DNS label plus the Azure URL:
<dnslabel>.<location>.cloudapp.azure.com

e) Choose an existing Virtual network or create a new one, the click OK.
f) Configure the management subnet for the FMCv.

Define a Management subnet name and review the Management subnet prefix. The recommended subnet name
is “management”.

g) Click OK.

Step 6 View the configuration summary, and then click OK.

Step 7 View the terms of use and then click Create.

Step 8 Select Notifications (bell icon) at the top of the portal to view the status of the deployment.

Figure 1: Azure Notifications

From here, you can click on the deployment to see further details or go to the resource group once the deployment is
successful. The total time until the FMCv is usable is approximately 30 minutes. Deployment times vary in Azure. Wait
until Azure reports that the FMCv VM is running.

Step 9 (Optional) Azure provides a number of tools to help you monitor the state of your VM, including Boot diagnostics and
Serial console. These tools allow you to see the state of your virtual machine as it boots up.

a) On the left menu, select Virtual machines.
b) Select your FMCv VM in the list. The overview page for the VM will open.
c) Scroll down to the Support + troubleshooting section and select Boot diagnostics or Serial console. A new pane

with either the boot diagnostic Screenshot and Serial log or the text-based Serial console opens and starts the
connection.
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The readiness of the FMCv's Web interface is confirmed if you see the login prompt on either boot diagnostics or
serial console.

Example:

Cisco Firepower Management Center for Azure v6.4.0 (build 44)
FMCv64East login: 

What to do next

• Verify that your FMCv deployment was successful. The Azure Dashboard lists the new FMCv VM under
Resource Groups, along with all of the related resources (storage, network, route table, etc.).

Verify the Firepower Management Center Virtual Deployment
After the FMCv VM is created, the Microsoft Azure Dashboard lists the new FMCv VM under Resource
groups. The corresponding storage account and network resources also are created and listed. The Dashboard
provides a unified view of your Azure assets, and provides an easy, at-a-glance assessment of the health and
performance of the FMCv.

Before you begin

The FMCv VM is started automatically. During deployment the status is listed as "Creating" while Azure
creates the VM, and then the status changes to "Running" once the deployment is complete.

Remember that deployment times vary in Azure, and the total time until the FMCv is usable is approximately
30 minutes, even when the Azure Dashboard shows the status of the FMCv VM as "Running".

Note

Step 1 To view the FMCv resource group and its resources after deployment is completed, from the left menu pane, click
Resource groups to access the Resource groups page.

The following figure shows an example of a Resources groups page in the Microsoft Azure portal. Notice the FMCv VM
as well as its corresponding resources (storage account, network resources, etc.).
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Figure 2: Azure FMCv Resource Group Page

Step 2 To view details of the FMCv VM associated with the resource group, click the name of the FMCv VM.

The following figure shows an example of the Virtual machine overview page associated with the FMCv VM. You
access this overview from the Resources groups page.

Figure 3: Virtual Machine Overview
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Observe that the status is Running. You can stop, start, restart, and delete an FMCv VM from the Virtual machine page
in the Microsoft Azure portal. Note that these controls are not graceful shutdown mechanisms for the FMCv; see Guidelines
and Limitations, on page 45 for graceful shutdown information.

Step 3 From the Virtual machine page, find the Public IP address assigned to the FMCv.

You can hover over the IP address and select Click to copy to copy the IP address.Note

Step 4 Direct your browser to https://public_ip/, where public_ip is the IP address assigned to theFMCv’s management interface
when you deployed the VM.

The login page appears.

Step 5 Log in using admin as the username and the password for the admin account that you specified when you deployed the
VM.

What to do next

• We recommend that you complete some administrative tasks that make your deployment easier to manage,
such as creating users and reviewing health and system policies. Refer to Firepower Management Center
Virtual Initial Administration and Configuration, on page 105 for an overview how to get started.

• You should also review your device registration and licensing requirements.

• For information on how you can begin to configure your Firepower system, see the complete Firepower
Management Center Configuration Guide for your software version.

Monitoring and Troubleshooting
This section includes general monitoring and troubleshooting guidelines for the Firepower Management
Center Virtual appliance deployed in Micosoft Azure. Monitoring and troubleshooting can relate to either the
deployment of the VM in Azure, or the FMCv appliance itself.

Azure Monitoring of the VM Deployment

Azure provides a number of tools under the Support + troubleshooting menu that provide quick access to
tools and resources to help you diagnose and resolve issues and receive additional assistance. Two items of
interest include:

• Boot diagnostics—Allows you to see the state of your FMCv VM as it boots up. The boot diagnostics
collects serial log information from the VM as well as screen shots. This can help you to diagnose any
startup issues.

• Serial console—The VM serial console in the Azure portal provides access to a text-based console. This
serial connection connects to the COM1 serial port of the virtual machine, providing serial and SSH
access to the FMCv's command line interface using the public IP address assigned to the FMCv.
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FMCv Monitoring and Logging

Troubleshoots and general logging operatations follow the same procedures as current FMC and FMCv
models. Refer to the System Monitoring and Troubleshooting section of the Firepower Management Center
Configuration Guide for your version.

In addition, the Microsoft Azure Linux Agent (waagent) manages Linux provisioning and VM interaction
with the Azure Fabric Controller. As such, the following are important logs for troubleshooting:

• /var/log/waagent.log—This log will have any errors from the FMC provisioning with Azure.

• /var/log/firstboot.S07install_waagent—This log will have any errors from the waagent installation.

Azure Provisioning Failures

Provisioning errors using the Azure Marketplace solution template are uncommon. However, should you
encounter a provisioning error, keep the following points in mind:

• Azure has a 20 minute timeout for the virtual machine to provision with the waagent, at which point it
is rebooted.

• If the FMC has trouble provisioning for any reason, the 20 minute timer tends to end in the middle of
the FMC database initialization, likely resulting in a deployment failure.

• If the FMC fails to provision in 20 minutes, we recommend that you start over.

• You can consult the /var/log/waagent.log for troubleshooting information.

• If you see HTTP connection errors in the serial console, this suggests that the waagent cannot communicate
with the fabric. You should review your network settings upon redeploy.

History for FMCv On the Microsoft Azure Cloud
Feature InformationReleasesFeature Name

Initial support.6.4.0Deploy the Firepower Management
Center Virtual (FMCv) on the
Microsoft Azure public cloud.
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C H A P T E R 6
Deploy the Firepower Management Center Virtual
On the Google Cloud Platform

Google Cloud Platform (GCP) is a public cloud service provided by Google that that allows you to build and
host applications Google’s scalable infrastructure. Google’s virtual private cloud (VPC) gives you the flexibility
to scale and control how workloads connect regionally and globally. GCP allows you to build your own VPCs
on top of Google’s public infrastructure.

You can deploy the Firepower Management Center Virtual (FMCv) on the GCP.

• About FMCv Deployment and GCP, on page 55
• Prerequisites for the FMCv on GCP, on page 56
• Guidelines and Limitations for the FMCv and GCP, on page 57
• Network Topology for FMCv on GCP, on page 57
• Deploy the FMCv on GCP, on page 58
• Access the FMCv Instance on GCP, on page 60

About FMCv Deployment and GCP
The Cisco Firepower Management Center Virtual (FMCv) runs the same software as physical Cisco FMC to
deliver proven security functionality in a virtual form factor. The FMCv can be deployed in the public GCP.
It can then be configured to manage virtual and physical Firepower devices.

GCP Machine Type Support

The FMCv supports both compute-optimized and general purpose machine high-memory machine types, and
high-CPU machine types. The FMCv supports the following GCP machine types.
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Supported machine types may change without notice.

Table 9: Supported Compute-Optimized Machine Types

AttributesCompute-Optimized Machine Types

RAM (GB)vCPUs

32 GB8c2-standard-8

64 GB16c2-standard-16

Table 10: Supported General Purpose Machine Types

AttributesGeneral Purpose Machine Types

RAM (GB)vCPUs

30 GB8n1-standard-8

60 GB16n1-standard-16

328n2-standard-8

6416n2-standard-16

28.832n1-highcpu-32

3232n2-highcpu-32

528n1-highmem-8

10416n1-highmem-16

324n2-highmem-4

648n2-highmem-8

Note

Prerequisites for the FMCv on GCP
• Create an GCP account at https://cloud.google.com.

• A Cisco Smart Account. You can create one at Cisco Software Central (https://software.cisco.com/).

• Configure all license entitlements for the security services from the Firepower Management Center.

• See “Licensing the Firepower System” in the Firepower Management Center Configuration Guide
for more information about how to manage licenses.

• Interface requirements:
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• Management interface — One used to connect a Firepower Threat Defense device to the Firepower
Management Center.

• Communications paths:

• Public IP for administrative access to the FMCv.

• For Firepower Management Center Virtual and Firepower System compatibility, see Cisco Firepower
Compatibility.

Guidelines and Limitations for the FMCv and GCP
Supported Features

• Deployment in the GCP Compute Engine

• Maximum of 32 vCPUs per instance (based on the GCP machine type)

• Licensing – Only BYOL is supported

Unsupported Features

• IPv6

• FMCv native HA

• Autoscale

• Transparent/inline/passive modes

• Multi-context mode

Network Topology for FMCv on GCP
The following figure illustrates the typical topology for the FMCv with 1 subnet configured in GCP.
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Figure 4: Topology Example for FMCv Deployment on GCP

Deploy the FMCv on GCP
The following procedures describe how to prepare your GCP environment and launch the FMCv instance.

Create VPC Networks
The FMCv deployment requires the Management VPC for the management FMCv. See Figure 1 on page 3
as a guide.

Step 1 In the GCP console, choose VPC networks, then click Create VPC Network.

Step 2 In the Name field, enter a descriptive name for your VPC network.

Step 3 From Subnet creation mode, click Custom.

Step 4 In the Name field under New subnet, enter the desired name.

Step 5 From the Region drop-down list, select the region appropriate for your deployment.

Step 6 From the IP address range field, enter the first network's subnet in CIDR format, such as 10.10.0.0/24.

Step 7 Accept the defaults for all other settings, then click Create.

Create the Firewall Rules
Each of the VPC networks requires firewall rules to allow SSH and traffic. Create the firewall rules for each
VPC network.

Step 1 In the GCP console, choose Networking > VPC network > Firewall, then click Create Firewall Rule.

Step 2 In the Name field, enter a descriptive name for your firewall rule, for example, vpc-asiasouth-mgmt-ssh.
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Step 3 From the Network drop-down list, select the name of the VPC network for which you are creating the firewall rule, for
example, fmcv-south-mgmt.

Step 4 From the Targets drop-down list, select the option applicable for your firewall rule, for example, All instances in the
network.

Step 5 In the Source IP ranges field, enter the source IP address ranges in CIDR format, for example, 0.0.0.0/0.

Traffic is only allowed from sources within these IP address ranges.

Step 6 Under Protocols and ports, select Specified protocols and ports.

Step 7 Add your security rules:

a) Add a rule to allow SSH (TCP/22).
b) Add a rule to allow TCP port 443.

You access the FMCv UI which requires port 443 to be opened for HTTPS connections.

Step 8 Click Create.

Create the FMCv Instance on GCP
You can follow the steps below to deploy an FMCv instance from the GCP console.

Step 1 Log into to the GCP Console.

Step 2 Click Navigation menu > Marketplace.

Step 3 Search the Marketplace for “Cisco Firepower Management Center (FMCv) BYOL” and choose the offering.

Step 4 Click Launch.

a) Deployment name — Specify a unique name for the instance.
b) Image version — Select the version from the drop-down list.
c) Zone — Select the zone where you want to deploy the FMCv.
d) Machine type — Choose the correct machine type based on the GCP Machine Type Support, on page 55.
e) SSH key (optional) — Paste the public key from the SSH key pair.

The key pair consists of a public key that GCP stores and a private key file that the user stores. Together they allow
you to connect to your instance securely. Be sure to save the key pair to a known location, as it will be required to
connect to the instance.

f) Choose whether to allow or Block project-wide SSH keys to access this instance. See the Google documentation
Allowing or blocking project-wide public SSH keys from a Linux instance.

g) Startup script — Provide the day0 configuration for FMCv.

The following example shows a sample day0 configuration you can copy and paste in the Startup script field:

{
"AdminPassword": "myPassword@123456",
"Hostname": "cisco-fmcv"
}

To prevent execution errors, you should validate your day0 configuration using a JSON validator.Tip

h) Select the Boot disk type from the drop-down list.

Cisco Firepower Management Center Virtual Getting Started Guide
59

Deploy the Firepower Management Center Virtual On the Google Cloud Platform
Create the FMCv Instance on GCP

https://console.cloud.google.com/
https://cloud.google.com/compute/docs/instances/adding-removing-ssh-keys#block-project-keys


By default, the Standard Persistent Disk is selected. Cisco recommends that you use the default Boot disk type.

i) The Boot disk size in GB default value is 250 GB. Cisco recommends that you keep the default boot disk size. It
cannot be less than 250 GB.

j) Click Add network interface to configure the Management interface.

You cannot add interfaces to an instance after you create it. If you create the instance with an improper
interface configuration, you must delete the instance and recreate it with the proper interface configuration.

Note

• From the Network drop-down list, select a VPC network, for example, vpc-branch-mgmt.

• From the External IP drop-down list, select the appropriate option.

For the management interface, select the External IP to Ephemeral.

• Click Done.

k) Firewall— Apply the firewall rules.

• Check the Allow TCP port 22 traffic from the Internet (SSH access) check box to allow SSH.

• Check the Allow HTTPS traffic from the Internet (FMC GUI) check box to allow HTTPS connections.

• Check the Allow TCP port 8305 traffic from the Internet (SFTunnel comm.) check box to allow the FMCv
and managed devices to communicate using a two-way, SSL-encrypted communication channel.

l) Click More to expand the view and make sure that IP Forwarding is set to On.

Step 5 Click Deploy.

Startup time depends on a number of factors, including resource availability. It can take up to 35 minutes for
the initialization to complete. Do not interrupt the initialization or you may have to delete the appliance and
start over.

Note

What to do next

View the instance details from the VM instance page of the GCP console. You’ll find the internal IP address,
external IP address, and controls to stop and start the instance. You need to stop the instance if you need to
edit it.

Access the FMCv Instance on GCP
Make sure that you have already created a firewall rule to allow SSH (TCP connections through port 22); see
Create the Firewall Rules, on page 58 for more information.

This firewall rule enables access to the FMCv instance and allows you to connect to the instance using the
following methods.

• External IP

• Browser window

• Any other SSH client or third-party tools

Cisco Firepower Management Center Virtual Getting Started Guide
60

Deploy the Firepower Management Center Virtual On the Google Cloud Platform
Access the FMCv Instance on GCP



• Serial console

• Gcloud command line

See the Google documentation, Connecting to instances for more information.

If you choose not to add a Day0 configuration, you can log in to the FMCv instance using the default credentials.
You are prompted to set the password on the first login attempt.

Note

Connect to the FMCv Instance Using the Serial Console

Step 1 In the GCP console, choose Compute Engine > VM instances.

Step 2 Click the FMCv instance name to open the VM instance details page.

Step 3 Under the Details tab, click Connect to serial console.

See the Google documentation, Interacting with the serial console for more information.

Connect to the FMCv Instance Using an External IP
The FMCv instance is assigned with an internal IP and an external IP. You can use the external IP to access
the FMCv instance.

Step 1 In the GCP console, choose Compute Engine > VM instances.

Step 2 Click the FMCv instance name to open the VM instance details page.

Step 3 Under the Details tab, click the drop-down menu for the SSH field.

Step 4 Select the desired option from the SSH drop-down menu.

You can connect to the FMCv instance using the following method.

• Any other SSH client or third-party tools—See the Google documentation, Connecting using third-party tools for
more information.

Connect to the FMCv Instance Using Gcloud

Step 1 In the GCP console, choose Compute Engine > VM instances.

Step 2 Click the FMCv instance name to open the VM instance details page.

Step 3 Under the Details tab, click the drop-down menu for the SSH field.

Step 4 Click View gcloud command > Run in Cloud Shell.
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The Cloud Shell terminal window opens. See the Google documentation, gcloud command-line tool overview, and gcloud
compute ssh for more information.
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C H A P T E R 7
Deploy the Firepower Management Center Virtual
On the Oracle Cloud Infrastructure

Oracle Cloud Infrastructure (OCI) is a public cloud computing service that enables you to run your applications
in a highly available, hosted environment offered by Oracle. OCI provides real-time elasticity for enterprise
applications by combining Oracle's autonomous services, integrated security, and serverless compute.

You can deploy the Firepower Management Center Virtual (FMCv) on OCI.

• About FMCv Deployment and OCI, on page 63
• Prerequisites for the FMCv on OCI, on page 64
• Guidelines and Limitations for the FMCv and OCI, on page 64
• Network Topology Example for FMCv on OCI, on page 65
• Deploy the FMCv on OCI, on page 65
• Access the FMCv Instance on OCI, on page 69

About FMCv Deployment and OCI
The Cisco Firepower Management Center Virtual (FMCv) runs the same software as physical Cisco FMC to
deliver proven security functionality in a virtual form factor. The FMCv can be deployed in the public OCI.
It can then be configured to manage virtual and physical Firepower devices.

OCI Compute Shapes

A shape is a template that determines the number of CPUs, amount of memory, and other resources that are
allocated to an instance. The FMCv support the following OCI shape types:

Table 11: Supported Compute Shapes for FMCv

AttributesShape Types

RAM (GB)oCPUs

60 GB4VM.Standard2.4
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Table 12: Supported Compute Shapes for FMCv 300 (7.1.0+)

AttributesShape Types

RAM (GB)oCPUs

240 GB

SSD storage: 2000 GB

16VM.Standard2.16

Supported shape types may change without notice.Note

• In OCI, 1 oCPU is equal to 2 vCPU.

• The FMCv requires 1 interface.

You create an account on OCI, launch a compute instance using the Cisco Firepower Management Center
virtual (FMCv) offering on the Oracle Cloud Marketplace, and choose an OCI shape.

Prerequisites for the FMCv on OCI
• Create an OCI account at https://www.oracle.com/cloud/.

• A Cisco Smart Account. You can create one at Cisco Software Central (https://software.cisco.com/).

• Configure all license entitlements for the security services from the Firepower Management Center.

• See “Licensing the Firepower System” in the Firepower Management Center Configuration Guide
for more information about how to manage licenses.

• Interface requirements:

• Management interface — One used to connect a Firepower Threat Defense device to the Firepower
Management Center.

• Communications paths:

• Public IP for administrative access to the FMCv.

• For Firepower Management Center Virtual and Firepower System compatibility, see Cisco Firepower
Compatibility.

Guidelines and Limitations for the FMCv and OCI
Supported Features

• Deployment in the OCI Virtual Cloud Network (VCN)

• Maximum of 8 vCPUs per instance
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• Routed mode (default)

• Licensing – Only BYOL is supported

• FMCv 300 for OCI—A new scaled FMCv image is available on the OCI platform that supports managing
up to 300 devices and has higher disk capacity (7.1.0+).

• FMCv high availability (HA) is supported on both FMCv models: FMCv and FMCv 300 (7.1.0+).

Unsupported Features

• IPv6

• Autoscale

• Transparent/inline/passive modes

• Multi-context mode

Network Topology Example for FMCv on OCI
The following figure illustrates the typical topology for the FMCv with 1 subnet configured in OCI.

Figure 5: Topology Example for FMCv Deployment on OCI

Deploy the FMCv on OCI

Configure the Virtual Cloud Network (VCN)
You configure the Virtual Cloud Network (VCN) for your FMCv deployment.

Cisco Firepower Management Center Virtual Getting Started Guide
65

Deploy the Firepower Management Center Virtual On the Oracle Cloud Infrastructure
Network Topology Example for FMCv on OCI



Before you begin

After you select a service from the navigation menu, the menu on the left includes the compartments list.
Compartments help you organize resources to make it easier to control access to them. Your root compartment
is created for you by Oracle when your tenancy is provisioned. An administrator can create more compartments
in the root compartment and then add the access rules to control which users can see and take action in them.
See the Oracle document “Managing Compartments” for more information.

Note

Step 1 Log into OCI and choose your region.

OCI is divided into multiple regions that are isolated from each other. The region is displayed in the upper right corner
of your screen. Resources in one region do not appear in another region. Check periodically to make sure you are in the
intended region.

Step 2 Choose Networking > Virtual Cloud Networks and click Create VCN.

Step 3 Enter a descriptive Name for your VCN, for example FMCv-Management.

Step 4 Enter a CIDR block for your VCN.

Step 5 Click Create VCN.

What to do next

You can continue with the following procedures to complete the Management VCN.

Create the Network Security Group
A network security group consists of a set of vNICs and a set of security rules that apply to the vNICs.

Step 1 Choose Networking > Virtual Cloud Networks > Virtual Cloud Network Details > Network Security Groups, and
click Create Network Security Group.

Step 2 Enter a descriptive Name for your Network Security Group, for example FMCv-Mgmt-Allow-22-443-8305.

Step 3 Click Next.

Step 4 Add your security rules:

a) Add a rule to allow TCP port 22 for SSH access.
b) Add a rule to allow TCP port 443 for HTTPS access.
c) Add a rule to allow TCP port 8305.

A Firepower device FMCv can be managed via the FMCv, which requires port 8305 to be opened for HTTPS
connections. You need port 443 to access the Firepower Management Center itself.

Step 5 Click Create.

Create the Internet Gateway
An Internet gateway is required to make your management subnet publicly accessible.
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Step 1 Choose Networking > Virtual Cloud Networks > Virtual Cloud Network Details > Internet Gateways, and click
Create Internet Gateway.

Step 2 Enter a descriptive Name for your Internet gateway, for example FMCv-IG.

Step 3 Click Create Internet Gateway.

Step 4 Add the route to the Internet Gateway:

a) Choose Networking > Virtual Cloud Networks > Virtual Cloud Network Details > Route Tables.
b) Click on the link for your default route table to add route rules.
c) Click Add Route Rules.
d) From the Target Type drop-down, select Internet Gateway.
e) Enter the Destination CIDR Block, for example 0.0.0.0/0.
f) From the Target Internet Gateway drop-down, select the gateway you created.
g) Click Add Route Rules.

Create the Subnet
Each VCN will have one subnet, at a minimum. You’ll create a Management subnet for the Management
VCN.

Step 1 Choose Networking > Virtual Cloud Networks > Virtual Cloud Network Details > Subnets, and click Create Subnet.

Step 2 Enter a descriptive Name for your subnet, for example Management.

Step 3 Select a Subnet Type (leave the recommended default of Regional).

Step 4 Enter a CIDR Block, for example 10.10.0.0/24. The internal (non-public) IP address for the subnet is taken from this
CIDR block.

Step 5 Select one of the route tables you created previously from the Route Table drop-down.

Step 6 Select the Subnet Access for your subnet.

For the Management subnet, this must be Public Subnet.

Step 7 Select the DHCP Option.

Step 8 Select a Security List that you created previously.

Step 9 Click Create Subnet.

What to do next

After you configure your Management VCN you are ready to launch the FMCv. See the following figure for
an example of the FMCv VCN configuration.
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Figure 6: FMCv Virtual Cloud Network

Create the FMCv Instance on OCI
You deploy the FMCv on OCI via a Compute instance using the Cisco Firepower Management Center Virtual
(FMCv) - BYOL offering on the Oracle Cloud Marketplace. You select the most appropriate machine shape
based on characteristics such as the number of CPUs, amount of memory, and network resources.

Step 1 Log into the OCI portal.

The region is displayed in the upper right corner of your screen. Make sure you are in the intended region.

Step 2 Choose Marketplace > Applications.

Step 3 Search Marketplace for “Cisco Firepower Management Center virtual (FMCv)” and choose the offering.

Step 4 Review the Terms and Conditions, and check the I have reviewed and accept the Oracle Terms of Use and the
Partner terms and conditions.check box.

Step 5 Click Launch Instance.

Step 6 Enter a descriptive Name for your instance, for example Cisco-FMCv.

Step 7 Click Change Shape and select the shape with the number of CPUs, amount of RAM, and number of interfaces required
for the FMCv, for example VM.Standard2.4 (see OCI Compute Shapes, on page 63).

Step 8 From the Virtual Cloud Network drop-down, choose the Management VCN.

Step 9 From the Subnet drop-down, choose the Management subnet if it's not autopopulated.

Step 10 Check Use Network Security Groups to Control Traffic and choose the security group you configured for the
Management VCN.

Step 11 Click the Assign a Public Ip Address radio button.

Step 12 Under Add SSH keys, click the Paste Public Keys radio button and paste the SSH key.

Linux-based instances use an SSH key pair instead of a password to authenticate remote users. A key pair consists of
a private key and public key. You keep the private key on your computer and provide the public key when you create
an instance. See Managing Key Pairs on Linux Instances for guidelines.

Step 13 Click the Show Advanced Options link to expand the options.

Step 14 Under Initialization Script, click the Paste Cloud-Init Script radio button to provide the day0 configuration for
FMCv. The day0 configuration is applied during the firstboot of the FMCv.

The following example shows a sample day0 configuration you can copy and paste in the Cloud-Init Script field:

{
"AdminPassword": "myPassword@123456",
"Hostname": "cisco-fmcv"
}
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Step 15 Click Create.

What to do next

Monitor the FMCv instance, which shows the state as Provisioning after you click the Create button. It’s
important to monitor the status. Look for the FMCv instance to go from Provisioning to Running state, which
indicates the FMCv boot is complete.

Access the FMCv Instance on OCI
You can connect to a running instance by using a Secure Shell (SSH) connection.

• Most UNIX-style systems include an SSH client by default.

• Windows 10 and Windows Server 2019 systems should include the OpenSSH client, which you'll need
if you created your instance using the SSH keys generated by Oracle Cloud Infrastructure.

• For other Windows versions you can download PuTTY, the free SSH client from http://www.putty.org.

Prerequisites

You'll need the following information to connect to the instance:

• The public IP address of the instance. You can get the address from the Instance Details page in the
Console. Open the navigation menu. Under Core Infrastructure, go to Compute and click Instances.
Then, select your instance. Alternatively, you can use the Core Services API ListVnicAttachments and
GetVnic operations.

• The username and password of your instance.

• The full path to the private key portion of the SSH key pair that you used when you launched the instance.

For more information about key pairs, see Managing Key Pairs on Linux Instances.

If you choose not to add a Day0 configuration, you can log in to the FMCv instance using the default credentials
(admin/Admin123).

You are prompted to set the password on the first login attempt.

Note

Connect to the FMCv Instance Using PuTTY
To connect to the FMCv instance from a Windows system using PuTTY:

Step 1 Open PuTTY.

Step 2 In the Category pane, select Session and enter the following:

• Host Name (or IP address):
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<username>@<public-ip-address>

Where:

<username> is the username for the FMCv instance.

<public-ip-address> is your instance public IP address that you retrieved from the Console.

• Port: 22

• Connection type: SSH

Step 3 In the Category pane, expand Window, and then select Translation.

Step 4 In the Remote character set drop-down list, select UTF-8.

The default locale setting on Linux-based instances is UTF-8, and this configures PuTTY to use the same locale.

Step 5 In the Category pane, expand Connection, expand SSH, and then click Auth.

Step 6 Click Browse, and then select your private key.

Step 7 Click Open to start the session.

If this is your first time connecting to the instance, you might see a message that the server's host key is not cached in
the registry. Click Yes to continue the connection.

Connect to the FMCv Instance Using SSH
To connect to the FMCv instance from a Unix-style system, log in to the instance using SSH.

Step 1 Use the following command to set the file permissions so that only you can read the file:

$ chmod 400 <private_key>

Where:

<private_key> is the full path and name of the file that contains the private key associated with the instance you
want to access.

Step 2 Use the following SSH command to access the instance.

$ ssh –i <private_key> <username>@<public-ip-address>

Where:

<private_key> is the full path and name of the file that contains the private key associated with the instance you
want to access.

<username> is the username for the FMCv instance.

<public-ip-address> is your instance IP address that you retrieved from the Console.
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Connect to the FMCv Instance Using OpenSSH
To connect to the FMCv instance from a Windows system, log in to the instance using OpenSSH.

Step 1 If this is the first time you are using this key pair, you must set the file permissions so that only you can read the file.

Do the following:

a) In Windows Explorer, navigate to the private key file, right-click the file, and then click Properties.
b) On the Security tab, click Advanced.
c) Ensure that the Owner is your user account.
d) Click Disable Inheritance, and then select Convert inherited permissions into explicit permissions on this object.
e) Select each permission entry that is not your user account and click Remove.
f) Ensure that the access permission for your user account is Full control.
g) Save your changes.

Step 2 To connect to the instance, open Windows PowerShell and run the following command:

$ ssh –i <private_key> <username>@<public-ip-address>

Where:

<private_key> is the full path and name of the file that contains the private key associated with the instance you
want to access.

<username> is the username for the FMCv instance.

<public-ip-address> is your instance IP address that you retrieved from the Console.
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C H A P T E R 8
Deploy the Firepower Management Center Virtual
Using OpenStack

You can deploy the Cisco Firepower Management Center Virtual (FMCv) on OpenStack.

• About FMCv Deployment on OpenStack, on page 73
• Prerequisites for the FMCv and OpenStack, on page 73
• Guidelines and Limitations for the FMCv and OpenStack, on page 74
• OpenStack Requirements for Firepower Deployment, on page 75
• Network Topology Example for FMCv on OpenStack, on page 76
• Deploy the FMCv on Openstack, on page 77

About FMCv Deployment on OpenStack
This guide describes how to deploy the Firepower Management Center Virtual (FMCv) in an OpenStack
environment. OpenStack is a free open standard cloud computing platform, mostly deployed as
infrastructure-as-a-service (IaaS) in both public and private clouds where virtual servers and other resources
are made available to users.

The FMCv runs the same software as physical Cisco Firepower Management Center to deliver proven security
functionality in a virtual form factor. The FMCv can be deployed on OpenStack. It can then be configured to
manage virtual and physical Firepower devices.

This deployment uses a KVM hypervisor to manage virtual resources. KVM is a full virtualization solution
for Linux on x86 hardware containing virtualization extensions (such as Intel VT). It consists of a loadable
kernel module, kvm.ko, that provides the core virtualization infrastructure and a processor specific module,
such as kvm-intel.ko. You can run multiple virtual machines running unmodified OS images using KVM.
Each virtual machine has private virtualized hardware: a network card, disk, graphics adapter, and so forth.

Because Firepower devices are already supported on the KVM hypervisor, no additional kernel packages or
drivers are needed to enable OpenStack support.

Prerequisites for the FMCv and OpenStack
• Download the FMCv qcow2 file from software.cisco.com and put it on your Linux host:

https://software.cisco.com/download/navigator.html
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• A software.cisco.com and Cisco service contract are required.

• FMCv supports deployment on opensource OpenStack environment and Cisco VIM managed OpenStack
environment.

Set up the OpenStack environment according to the OpenStack guidelines.

• See the opensource OpenStack document:

Stein Release - https://docs.openstack.org/project-deploy-guide/openstack-ansible/stein/overview.html

Queens Release - https://docs.openstack.org/project-deploy-guide/openstack-ansible/queens/
overview.html

• See the Cisco Virtualized Infrastructure Manager (VIM) OpenStack document: Cisco Virtualized
Infrastructure Manager Documentation, 3.4.3 to 3.4.5

• Licensing:

• You configure license entitlements for the security services from the Firepower Management Center.

• See “Licensing the Firepower System” in the Firepower Management Center Configuration Guide
for more information about how to manage licenses.

• Interface requirements:

• Management interface — One used to connect the Firepower device to the Firepower Management
Center.

• Communications paths:

• Floating IPs for access into the FMCv.

• Minimum supported FMCv version:

• Firepower Version 7.0.

• For OpenStack requirements, see OpenStack Requirements for Firepower Deployment, on page 75.

• For Firepower Management Center Virtual and Firepower System compatibility, see Cisco Firepower
Compatibility.

Guidelines and Limitations for the FMCv and OpenStack
Supported Features

The FMCv on OpenStack supports the following features:

• Deployment of FMCv on the KVM hypervisor running on a compute node in your OpenStack environment.

• OpenStack CLI

• Heat template-based deployment

• Licensing ― Only BYOL is supported
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• Drivers - VIRTIO, VPP, and SRIOV

Unsupported Features

The FMCv on OpenStack does not support the following:

• Autoscale

• OpenStack releases other than the OpenStack Stein and Queens releases

• Operating systems other than the Ubuntu 18.04 version and Red Hat Enterprise Linux (RHEL) 7.6

OpenStack Requirements for Firepower Deployment
The OpenStack environment must conform to the following supported hardware and software requirements.

Table 13: Hardware and Software Requirements

NotesSupported VersionsCategory

2 UCS servers are recommended,
one each for os-controller and
os-compute nodes.

UCS C240 M5Server

These are the supported drivers.VIRTIO, IXGBE, I40EDriver

This is the recommended OS on
UCS servers.

Ubuntu Server 18.04Operating System

Details of the various OpenStack
releases are available at:

https://releases.openstack.org/

Stein releaseOpenStack Version

Table 14: Hardware and Software Requirements for Cisco VIM Managed OpenStack

NotesSupported VersionsCategory

5 UCS servers are recommended,
three each for os-controller and
Two or more for os-compute nodes.

UCS C220-M5/UCS C240-M4Server Hardware

These are the supported drivers.VIRTIO, SRIOV, and VPPDrivers

This is the recommended OS.Red Hat Enterprise Linux 7.6Operating System

Details of the various OpenStack
releases are available at:

https://releases.openstack.org/

OpenStack 13.0 (Queens Release)OpenStack Version

See the Cisco VIM OpenStack
document.

Cisco VIM 3.4.4Cisco VIM Version
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OpenStack Platform Topology

The following figure shows the recommended topology to support Firepower deployments in OpenStack
using two UCS servers.

Figure 7: OpenStack Platform Topology

Network Topology Example for FMCv on OpenStack
The following figure shows a network topology example for the FMCv in OpenStack.

Figure 8: Topology Example with FMCv and Firepower on OpenStack
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Deploy the FMCv on Openstack
Cisco provides sample heat templates for deploying the FMCv. Steps for creating the OpenStack infrastructure
resources are combined in a heat template (deploy_os_infra.yaml) file to create networks, subnets,
and router interfaces. At a high-level, the FMCv deployment steps are categorized into the following sections.

• Upload the FMCv qcow2 image to the OpenStack Glance service.

• Create the network infrastructure.

• Network

• Subnet

• Router interface

• Create the FMCv instance.

• Flavor

• Security Groups

• Floating IP

• Instance

You can deploy the FMCv on OpenStack using the following steps.

Upload the FMCv Image to OpenStack
Copy the FMCv qcow2 image to the OpenStack controller node, and then upload the image to the OpenStack
Glance service.

Before you begin

• Download the Firepower Management Center Virtual qcow2 file from Cisco.com and put it on your
Linux host:

https://software.cisco.com/download/navigator.html

Step 1 Copy the qcow2 image file to the OpenStack controller node.

Step 2 Upload the FMCv image to the OpenStack Glance service.

root@ucs-os-controller:$ openstack image create <fmcv_image> --public --disk-
format qcow2 --container-format bare --file ./<fmcv_qcow2_file>

Step 3 Verify if the FMCv image upload is successful.

root@ucs-os-controller:$ openstack image list

Example:
root@ucs-os-controller:$ openstack image 
list+--------------------------------------+-------------------+--------+
| ID                                   | Name              | Status 
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|+--------------------------------------+-------------------+--------+
| b957b5f9-ed1b-4975-b226-4cddf5887991 | fmcv-7-0-image | active 
|+--------------------------------------+-------------------+--------+

The uploaded image and its status is displayed.

What to do next

Create the network infrastructure using the deploy_os_infra.yaml template.

Create the Network Infrastructure for OpenStack and FMCv
Deploy the OpenStack infrastructure heat template to create the network infrastructure.

Before you begin

Heat template files are required to create the network infrastructure and the required components for FMCv,
such as flavor, networks, subnets, router interfaces, and security group rules:

• env.yaml ― Defines the resources created to support the FMCv on the compute node, such as the image
name, interfaces, and IP addresses.

• deploy_os_infra.yaml ― Defines the environment for the FMCv, such as the network and subnets.

Templates for your FMCv version are available from the GitHub repository at:

• https://github.com/CiscoDevNet/cisco-ftdv

Note that Cisco-provided templates are provided as open source examples, and are not covered within the
regular Cisco TAC support scope. Check GitHub regularly for updates and ReadMe instructions.

Important

Step 1 Deploy the infrastructure heat template file.

root@ucs-os-controller:$ openstack stack create <stack-name> -e <environment files name> -t <deployment file
name>

Example:
root@ucs-os-controller:$ openstack stack create infra-stack -e env.yaml -t deploy_os_infra.yaml

Step 2 Verify if the infrastructure stack is created successfully.

root@ucs-os-controller:$ openstackstack list

Example:
root@ucs-os-controller:$ openstack stack list
+--------------------------------------+-------------+----------------------------------+-----------------+----------------------+------------
--+
| ID | Stack Name | Project | Stack Status | Creation Time | Updated Time |
+--------------------------------------+-------------+----------------------------------+-----------------+----------------------+------------
--+
| b30d5875-ce3a-4258-a841-bf2d09275929 | infra-stack | 13206e49b48740fdafca83796c6f4ad5 | 
CREATE_COMPLETE | 2020-12-07T15:10:24Z | None |
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+--------------------------------------+-------------+----------------------------------+-----------------+----------------------+------------
--+

What to do next

Create the FMCv instance on OpenStack.

Create the FMCv Instance on OpenStack
Use the sample heat template to deploy FMCv on OpenStack.

Before you begin

A heat template is required to deploy the FMCv on OpenStack:

• deploy_fmcv.yaml

Templates for your FMCv version are available from the GitHub repository at:

• https://github.com/CiscoDevNet/cisco-ftdv

Note that Cisco-provided templates are provided as open source examples, and are not covered within the
regular Cisco TAC support scope. Check GitHub regularly for updates and ReadMe instructions.

Important

Step 1 Deploy the FMCv heat template file (deploy_fmcv.yaml) to create the FMCv instance.

root@ucs-os-controller:$ openstack stack create fmcv-stack -e env.yaml-t deploy_fmcv.yaml

Example:
+---------------------+--------------------------------------+
| Field               | Value                                |
+---------------------+--------------------------------------+
| id                  | 96c8c126-107b-4733-8f6c-eb15a637219f |
| stack_name          | fmcv-stack                           |
| description         | FMCv template                         |
| creation_time       | 2020-12-07T14:55:05Z                 |
| updated_time        | None                                 |
| stack_status        | CREATE_IN_PROGRESS                   |
| stack_status_reason | Stack CREATE started                 |
+---------------------+--------------------------------------+

Step 2 Verify that your FMCv stack is created successfully.

root@ucs-os-controller:$ openstack stack list

Example:
+--------------------------------------+-------------+----------------------------------+-----------------+----------------------+------+
| ID                                   | Stack Name  | Project                          | Stack Status
    | Creation Time    | Updated Time |
+--------------------------------------+-------------+----------------------------------+-----------------+----------------------+--------------+
| 14624af1-e5fa-4096-bd86-c453bc2928ae | fmcv-stack  | 13206e49b48740fdafca83796c6f4ad5 | 
CREATE_COMPLETE | 2020-12-07T14:55:05Z | None         |
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| 198336cb-1186-45ab-858f-15ccd3b909c8 | infra-stack | 13206e49b48740fdafca83796c6f4ad5 | 
CREATE_COMPLETE | 2020-12-03T10:46:50Z | None         |
+--------------------------------------+-------------+----------------------------------+-----------------+----------------------+--------------+
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C H A P T E R 9
Deploy the Firepower Management Center Virtual
Using Cisco Hyperflex

Cisco HyperFlex systems deliver hyperconvergence for any application, and anywhere. HyperFlex with Cisco
Unified Computing System (Cisco UCS) technology that is managed through the Cisco Intersight cloud
operations platform can power applications and data anywhere, optimize operations from a core datacenter
to the edge and into public clouds, and therefore increase agility through accelerating DevOps practices.

You can deploy the Firepower Management Center Virtual (FMCv) on Cisco Hyperflex.

• Host System Requirements, on page 81
• Limitations and Guidelines for the Firepower Management Center Virtual on Cisco HyperFlex, on page

82
• Deploy the FMCv to Cisco Hyperflex on a vSphere vCenter Server, on page 83
• Power On and Initialize the Virtual Appliance, on page 85

Host System Requirements
Firepower Management Center Virtual Requires 28 GB RAM

We recommend you do not decrease the default settings: 32 GB RAM for most Firepower Management Center
Virtual (FMCv) instances, 64 GB for the FMCv 300. To improve performance, you can always increase a
virtual appliance’s memory and number of CPUs, depending on your available resources.

Memory and Resource Requirements

• You can deploy the Firepower Management Center Virtual using HyperFlex cluster provisioning hosted
on HyperFlex ESX and ESXi hypervisors. See the Cisco Firepower Compatibility Guide for hypervisor
compatibility.

• For the FMCv, check the latest Firepower Release Notes for details on whether a new release affects
your environment. You may be required to increase resources to deploy the latest version of Firepower.

• The specific hardware used for FMCv deployments can vary, depending on the number of instances
deployed and usage requirements. Each virtual appliance you create requires a minimum resource
allocation—memory, number of CPUs, and disk space—on the host machine.

• The following table lists the recommended and default settings for the FMCv appliance.
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Be sure to allocate enough memory to ensure the optimal performance of your
FMCv. If your FMCv has less than 32 GB memory, your system could experience
policy deployment issues. Do not decrease the default settings, as they are the
minimum required to run the system software.

Important

Table 15: FMCv Virtual Appliance Settings

Adjustable Setting?RecommendedDefaultMinimumSetting

With restrictions.32 GB32 GB28 GBMemory

Yes, up to 8844Virtual CPUs

No, based on Disk Format selectionn/a250 GB250 GBHard disk
provisioned size

Table 16: FMCv300 Virtual Appliance Settings

Adjustable Setting?DefaultSetting

Yes64 GBMemory

No32Virtual CPUs

No, based on Disk Format selection2.2 TBHard disk
provisioned size

For a list of supported platforms and specific hardware and operating system requirements, see the Compatibility
Guide.

Limitations and Guidelines for the Firepower Management
Center Virtual on Cisco HyperFlex

Limitations

The following limitations exist when you deploy the Firepower Management Center Virtual for Cisco
HyperFlex:

• FMCv appliances do not have serial numbers. The System > Configuration page shows either None or
Not Specified depending on the virtual platform.

• Cloning a virtual machine is not supported.

• Restoring a virtual machine with snapshot is not supported.

• VMware Workstation, Player, Server, and Fusion do not recognize OVF packaging and are not supported.
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OVF File Guidelines

Virtual appliances use Open Virtual Format (OVF) packaging. You deploy a virtual appliance with a virtual
infrastructure (VI) OVF template. The selection of the OVF file is based on the deployment target-

For deployment on vCenter—Cisco_Firepower_Management_Center_Virtual_VMware-VI-X.X.X-xxx.ovf

where X.X.X-xxx is the version and build number of the Firepower System software you want to deploy. The
installation process allows you to perform the entire initial setup for FMCv appliance. You can specify:

• A new password for the admin account.

• Network settings that allow the appliance to communicate on your management network.

High Availability Support

You can establish high availability (HA) between two Firepower Management Center Virtual (FMCv) virtual
appliances deployed on Hyperflex host:

• FMCv HA is supported on both FMCv models: FMCv and FMCv 300.

• The two FMCv virtual appliances in a high availability configuration must be the same model. You
cannot pair an FMCv with an FMCv 300.

• To establish FMCv HA, FMCv requires an extra FMCv license entitlement for each FTD device that it
manages in the HA configuration. However, the required FTD feature license entitlement for each FTD
device has no change regardless of the FMCv HA configuration. See License Requirements for FTD
Devices in a High Availability Pair in the Firepower Management Center Configuration Guide for
guidelines about licensing.

• If you break the FMCv HA pair, the extra FMCv license entitlement is released, and you need only one
entitlement for each FTD device.

See Establishing Firepower Management Center High Availability in the Firepower Management Center
Configuration Guide for guidelines about high availability.

Related Documents

Release Notes for Cisco HX Data Platform

Configuration Guides for Cisco HX Data Platform

Cisco HyperFlex 4.0 for Virtual Server Infrastructure with VMware ESXi

Cisco HyperFlex Systems Solutions Overview

Cisco HyperFlex Systems Documentation Roadmap

DeploytheFMCvtoCiscoHyperflexonavSpherevCenterServer
Use this procedure to deploy the Firepower Management Center Virtual (FMCv) appliance to Cisco Hyperflex
on a vSphere vCenter Server.
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Before you begin

• Ensure that you have deployed Cisco HyperFlex and performed all the post-installation configuration
tasks. For more information, see Cisco HyperFlex Systems Documentation Roadmap.

• You must have at least one network configured in vSphere (for management) before you deploy the
FMCv.

• Download the FMCv VI OVF template file from Cisco.com:
Cisco_Firepower_Management_Center_Virtual-VI-X.X.X-xxx.ovf, where X.X.X-xxx is the version and
build number.

Step 1 Log in to the vSphere Web Client.

Step 2 Select the Hyperflex cluster where you want to deploy the FMCv, and click ACTIONS > Deploy OVF Template.

Step 3 Browse your file system for the OVF template source location, and click NEXT

You want to select the Firepower Management Center Virtual VI OVF template:

Cisco_Firepower_Management_Center_Virtual-VI-X.X.X-xxx.ovf

where X.X.X-xxx is the version and build number of the archive file you downloaded.

Step 4 Specify a name and folder for the FMCv deployment, and click NEXT.

Step 5 Select a compute resource, and wait until the compatibility check is complete. If the compatibility check succeeds,
click NEXT.

Step 6 Review the OVF template information (product name, vendor, version, download size, size on disk, and description),
and click NEXT.

Step 7 Review and accept the license agreement that is packaged with the OVF template (VI templates only), and click NEXT.

Step 8 Select a storage location and virtual disk format, and click NEXT.

On this window, you select from datastores already configured on the destination HyperFlex cluster. The virtual machine
configuration file and virtual disk files are stored on the datastore. Select a datastore large enough to accommodate the
virtual machine and all of its virtual disk files.

When you select Thick Provisioned as the virtual disk format, all storage is immediately allocated. When you select
Thin Provisioned as the virtual disk format, storage is allocated on demand as data is written to the virtual disks. Thin
provisioning can also reduce the amount of time it takes to deploy the virtual appliance.

Step 9 Map the networks specified in the OVF template to networks in your inventory, and click NEXT.

Step 10 Set the user-configurable properties packaged with the OVF template:

You must mandatorily configure all the required customizations in this step.Note

a) Password

Set the password for FMCv admin access.

b) Network

Set the network information, including the Fully Qualified Domain Name (FQDN), DNS, and network protocol
(IPv4 or IPv6).

c) Click NEXT.
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Step 11 Review and verify the displayed information. To begin the deployment with these settings, click FINISH. To make
any changes, click BACK to navigate back through the screens.

After you complete the wizard, the vSphere Web Client processes the virtual machine; you can see the “Initialize OVF
deployment” status in the Global Information area Recent Tasks pane.

When it is finished, you see the Deploy OVF Template completion status.

The Cisco Firepower Management Center Virtual instance appears under the specified data center in the Inventory.
Booting up the new VM could take up to 30 minutes.

To successfully register the Cisco Firepower Management Center Virtual with the Cisco Licensing Authority,
the Firepower Management Center requires Internet access. You need to perform additional configuration
after deployment to achieve Internet access and successful license registration. DNS server configuration is
mandatory for license registration.

Note

What to do next

Initialize the virtual appliance; see Power On and Initialize the Virtual Appliance, on page 18

Power On and Initialize the Virtual Appliance
After you complete the deployment of the virtual appliance, initialization starts automatically when you power
on the virtual appliance for the first time.

Startup time depends on a number of factors, including server resource availability. It can take up to 40 minutes
for the initialization to complete. Do not interrupt the initialization or you may have to delete the appliance
and start over.

Caution

Step 1 Power on the appliance.

In the vSphere Client, right-click the name of your virtual appliance from the inventory list, then select Power > Power
On from the context menu.

Step 2 Monitor the initialization on the VM console.

What to do next

After you deploy a FMCv, you must complete a setup process to configure the new appliance to communicate
on your trusted management network. If you deploy with a VI OVF template on Hyperflex, setting up a FMCv
is a two-step process.

• To complete the initial setup of the FMCv, see Firepower Management Center Virtual Initial Setup, on
page 97.

• For an overview of the next steps needed in your FMCv deployment, see Firepower Management Center
Virtual Initial Administration and Configuration.
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C H A P T E R 10
Deploy the Firepower Management Center Virtual
Using Nutanix

Nutanix AHV is a native bare metal Type-1 hypervisor, Hyper-converged Infrastructure HCI with cloud
enabled features and functionality.

This chapter describes how the FMCv functions in the Nutanix environment with AHV hypervisor, including
feature support, system requirements, guidelines, and limitations.

You can deploy the Firepower Management Center Virtual (FMCv) on Nutanix AHV.

• Host System Requirements, on page 87
• Prerequisites for Deploying Firepower Management Center Virtual on Nutanix, on page 88
• Guidelines and Limitations for Firepower Management Center Virtual and Nutanix, on page 89
• How to Deploy the Firepower Management Center Virtual on Nutanix, on page 90

Host System Requirements
We recommend you do not decrease the default settings: 32 GB RAM for most Firepower Management Center
(FMCv) instances, 64 GB for the FMCv 300. To improve performance, you can always increase a virtual
appliance’s memory and number of CPUs, depending on your available resources.

Memory and Resource Requirements

• You can run multiple virtual machines running unmodified OS images using Nutanix AHV. Each virtual
machine has private virtualized hardware: a network card, disk, graphics adapter, and so forth. See the
Cisco Firepower Compatibility Guide for hypervisor compatibility.

• Check for the latest Firepower Release Notes for details on whether a new release affects your
environment. You may be required to increase resources to deploy the latest version of Firepower.

• The specific hardware used for FMCv deployments can vary, depending on the number of instances
deployed and usage requirements. Each virtual appliance you create requires a minimum resource
allocation—memory, number of CPUs, and disk space—on the host machine.

• The following lists the recommended and default settings for the FMCv appliance on Nutanix AHV:

• Processors

• Requires 4 vCPUs
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• Memory

• Minimum required 28 GB / Recommended (default) 32 GB RAM

The Firepower Management Center (FMCv) platform fails if you allocate less
than 28 GB RAM to the virtual appliance.

Important

• Networking

• Supports virtio drivers

• Supports one management interface

• Host storage per Virtual Machine

• The FMCv requires 250 GB

• Supports virtio and scsi block devices

• Console

• Supports terminal server via telnet

Prerequisites for Deploying Firepower Management Center
Virtual on Nutanix

Firepower Versions

Device VersionManager Version

Firepower Threat Defense 7.0Firepower Device Manager 7.0

Firepower Management Center Virtual 7.0

See the Cisco Firepower Compatibility Guide for the most current information about hypervisor support for
the Firepower Threat Defense Virtual.

Download the Firepower Management Center qcow2 file from Cisco.com and put it on your Nutanix Prism
Web Console:

https://software.cisco.com/download/navigator.html

A Cisco.com login and Cisco service contract are required.Note

Firepower Management Center Virtual Licenses

• Configure all license entitlements for the security services from the Firepower Management Center.
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• See Licensing the Firepower System in the Firepower Management Center Configuration Guide for more
information about how to manage licenses.

Nutanix Components and Versions

VersionComponent

5.15.5 LTS and laterNutanix Acropolis Operating System (AOS)

4.0.0.1Nutanix Cluster Check (NCC)

20201105.12 and laterNutanix AHV

-Nutanix Prism Web Console

Guidelines and Limitations for Firepower Management Center
Virtual and Nutanix

Supported Features

Deployment Mode–Standalone

Unsupported Features

Firepower Management Center Virtual appliances do not have serial numbers. The System > Configuration
page shows either None or Not Specified depending on the virtual platform.

• Nested hypervisors (Nutanix AHV running on top of ESXi) are not supported. Only Nutanix standalone
cluster deployments are supported.

• High Availability is not supported.

• Nutanix AHV does not support SR-IOV and DPDK-OVS

Related Documentation

• Nutanix Release Notes

• Nutanix Field Installation Guide

• Hardware Support on Nutanix
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How to Deploy the Firepower Management Center Virtual on
Nutanix

More InformationTaskStep

Prerequisites for Deploying Firepower Management
Center Virtual on Nutanix, on page 88

Review the prerequisites.1

Upload the Firepower Management Center Virtual
QCOW2 File to Nutanix, on page 90

Upload the Firepower Management Center
Virtual qcow2 file to the Nutanix
environment.

2

Prepare the Day 0 Configuration File, on page 91(Optional) Prepare a Day 0 configuration file
that contains the initial configuration data
that gets applied at the time a virtual machine
is deployed.

3

Deploy the Firepower Management Center Virtual to
Nutanix, on page 92

Deploy the Firepower Management Center
Virtual to the Nutanix environment.

4

Complete the FMCv Setup, on page 93(Optional) If you did not use a Day 0
configuration file to set up the Firepower
Management Center Virtual, complete the
setup by logging in to the CLI.

5

Upload the Firepower Management Center Virtual QCOW2 File to Nutanix
To deploy an FMCv to the Nutanix environment, you must create an image from the FMCv qcow2 disk file
in the Prism Web Console.

Before you begin

Download the FMCv qcow2 disk file from Cisco.com: https://software.cisco.com/download/navigator.html

Step 1 Log in to the Nutanix Prism Web Console.

Step 2 Click the gear icon to open the Settings page.

Step 3 Click Image Configuration from the left pane.

Step 4 Click Upload Image.

Step 5 Create the image.

a. Enter a name for the image.

b. From the Image Type drop-down list, choose DISK.

c. From the Storage Container drop-down list, choose the desired container.

d. Specify the location of the FMCv qcow2 disk file.

You can either specify a URL (to import the file from a web server) or upload the file from your workstation.
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e. Click Save.

Step 6 Wait until the new image appears in the Image Configuration page.

Prepare the Day 0 Configuration File
You can prepare a Day 0 configuration file before you deploy the FMCv. This file is a text file that contains
the initial configuration data that gets applied at the time a virtual machine is deployed.

Keep in mind that:

• If you deploy with a Day 0 configuration file, the process allows you to perform the entire initial setup
for FMCv appliance.

• If you deploy without a Day 0 configuration file, you must configure Firepower System-required settings
after launch; see Complete the FMCv Setup, on page 93 for more information.

You can specify:

• The End User License Agreement (EULA) acceptance.

• A hostname for the system.

• A new administrator password for the admin account.

• Network settings that allow the appliance to communicate on your management network.

Step 1 Create a new text file using a text editor of your choice.

Step 2 Enter the configuration details in the text file as shown in the following sample. Note that the text is in JSON format.
You can validate the text using a validator tool before copying the text.

Example:
#FMC
{
    "EULA": "accept",
    "Hostname": "FMC-Production",
    "AdminPassword": "Admin123",
    "DNS1": "10.1.1.5",
    "DNS2": "192.168.1.67",
    "IPv4Mode": "manual",
    "IPv4Addr": "10.12.129.45",
    "IPv4Mask": "255.255.0.0",
    "IPv4Gw": "10.12.0.1",
    "IPv6Mode": "disabled",
    "IPv6Addr": "",
    "IPv6Mask": "",
    "IPv6Gw": "",
}

Step 3 Save the file as “day0-config.txt.”

Step 4 Repeat Step 1–3 to create unique default configuration files for each FMCv that you want to deploy.

Cisco Firepower Management Center Virtual Getting Started Guide
91

Deploy the Firepower Management Center Virtual Using Nutanix
Prepare the Day 0 Configuration File



Deploy the Firepower Management Center Virtual to Nutanix

Before you begin

Ensure that the image of the FMCv that you plan to deploy is appearing on the Image Configuration page.

Step 1 Log in to the Nutanix Prism Web Console.

Step 2 From the main menu bar, click the view drop-down list, and choose VM.

Step 3 On the VM Dashboard, click Create VM.

Step 4 Do the following:

a. Enter a name for the FMCv instance.

b. Optionally enter a description for the FMCv instance.

c. Select the timezone that you want the FMCv instance to use.

Step 5 Enter the compute details.

a. Enter the number of virtual CPUs to allocate to the FMCv instance.

b. Enter the number of cores that must be assigned to each virtual CPU.

c. Enter the amount of memory (in GB) to allocate to the FMCv instance.
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Step 6 Attach a disk to the FMCv instance.

a. Under Disks, Click Add New Disk.

b. From the Type drop-down list, choose DISK.

c. From the Operation drop-down list, choose Clone from Image Service.

d. From the Bus Type drop-down list, choose SCSI, PCI, or SATA.

e. From the Image drop-down list, choose the image that you want to use.

f. Click Add.

Step 7 Under Network Adapters (NIC), click Add New NIC, select a network, and click Add.

Step 8 Configure affinity policy for the FMCv.

Under VM Host Affinity , click Set Affinity, select the hosts, and click Save.

Select more than one host to ensure that the FMCv can be run even if there is a node failure.

Step 9 If you have prepared a Day 0 configuration file, do the following:

a. Select Custom Script.

b. Click Upload A File, and choose the Day 0 configuration file (day0-config.txt).

All the other custom script options are not supported in this release.Note

Step 10 Click Save to deploy the FMCv. The FMCv instance appears in the VM table view.

Step 11 In the VM table view, select the newly created FMCv instance, and click Power On.

Step 12 After FMCv is powered on, verify the status. Go to Home > VM > FMCv that you deployed and log in.

Complete the FMCv Setup
For all Firepower Management Centers, you must complete a setup process that allows the appliance to
communicate on your management network. If you deploy without a Day 0 configuration file, setting up a
FMCv is a two-step process:

Step 1 After you initialize the FMCv, run a script at the appliance console that helps you configure the appliance to communicate
on your management network.

Step 2 Then, complete the setup process using a computer on your management network to browse to the web interface of the
FMCv.

Step 3 Complete the initial setup on FMCv using the CLI. See Configure Network Settings Using a Script, on page 94.

Step 4 Complete the setup process using a computer on your management network to browse to the web interface of the FMCv.
See Perform Initial Setup Using the Web Interface, on page 94.
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Configure Network Settings Using a Script
The following procedure describes how you complete the initial setup on a FMCv using the CLI.

Step 1 At the console, log into the FMCv appliance. Use admin as the username and Admin123 as the password. If you are
using the Nutanix console, the default password is Admin123.

If prompted, reset the password.

Step 2 At the admin prompt, run the following script:

Example:
sudo /usr/local/sf/bin/configure-network

On first connection to the FMCv you are prompted for post-boot configuration.

Step 3 Follow the script’s prompts.

Configure (or disable) IPv4 management settings first, then IPv6. If you manually specify network settings, you must
enter IPv4 or IPv6 addresses.

Step 4 Confirm that your settings are correct.

Step 5 Log out of the appliance.

What to do next

• Complete the setup process using a computer on your management network to browse to the web interface
of the FMCv.

Perform Initial Setup Using the Web Interface
The following procedure describes how you complete the initial setup on a FMCv using the web interface.

Step 1 Direct your browser to default IP address of the FMCv’s management interface:

Example:
https://192.168.45.45

Step 2 Log into the Firepower Management Center Virtual appliance. Use admin as the username and Admin123 as the password.
If prompted, reset the password.

The setup page appears. You must change the administrator password, specify network settings if you haven’t already,
and accept the EULA.

Step 3 When you are finished, click Apply. The FMCv is configured according to your selections. After an intermediate page
appears, you are logged into the web interface as the admin user, which has the Administrator role.

The FMCv is configured according to your selections. After an intermediate page appears, you are logged into the web
interface as the admin user, which has the Administrator role.
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What to do next

• For more information about the initial setup of the FMCv, see Firepower Management Center Virtual
Initial Setup, on page 97

• For an overview of the next steps needed in your FMCv deployment, see the chapter Firepower
Management Center Virtual Initial Administration and Configuration.
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C H A P T E R 11
Firepower Management Center Virtual Initial
Setup

This chapter describes the initial setup process you need to perform after you deploy a Firepower Management
Center Virtual (FMCv) appliance.

• FMC Initial Setup Using the CLI for Versions 6.5 and Later, on page 97
• Perform Initial Setup at the Web Interface for Versions 6.5 and Later, on page 99
• Review Automatic Initial Configuration for Versions 6.5 and Later, on page 103

FMC Initial Setup Using the CLI for Versions 6.5 and Later
After you deploy an FMCv, you can access the appliance console for initial setup.You can perform initial
setup using the CLI as an alternative to using the web interface. You must complete an Initial Configuration
Wizard that configures the new appliance to communicate on your trusted management network. The wizard
requires that you accept the end user license agreement (EULA) and change the administrator password.

Before you begin

• Be sure you have the following information needed for the FMCv to communicate on your management
network:

• An IPv4 management IP address.

The FMC management interface is preconfigured to accept an IP4 address assigned by DHCP.
Consult with your system administrator to determine what IP address your DHCP has been configured
to assign to the FMC MAC address. In scenarios where no DHCP is available, the FMC management
interface uses the IPv4 address 192.168.45.45.

• A network mask and a default gateway (if not using DHCP).

Step 1 Log into the FMCv at the console using admin as the username and Admin123 as the password for the admin account.
Note that the password is case-sensitive.

Step 2 When prompted, press Enter to display the End User License Agreement (EULA).

Step 3 Review the EULA. When prompted, enter yes, YES, or press Enter to accept the EULA.
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You cannot proceed without accepting the EULA. If you respond with anything other than yes, YES, or Enter,
the system logs you out.

Important

Step 4 To ensure system security and privacy, the first time you log in to the FMC you are required to change the admin password.
When the system prompts for a new password, enter a new password complying with the restrictions displayed, and enter
the same password again when the system prompts for confirmation.

The FMC compares your password against a password cracking dictionary that checks not only for many
English dictionary words but also other character strings that could be easily cracked with common password
hacking techniques. For example, the initial configuration script may reject passwords such as "abcdefg" or
"passw0rd".

Note

On completion of the initial configuration process the system sets the passwords for the two admin accounts
(one for web access and the other for CLI access) to the same value, complying with the strong password
requirements described in the Firepower Management Center Configuration Guide for your version. If you
change the password for either admin account thereafter, they will no longer be the same, and the strong
password requirement can be removed from the web interface admin account.

Note

Step 5 Answer the prompts to configure network settings.

When following the prompts, for multiple-choice questions, your options are listed in parentheses, such as (y/n).
Defaults are listed in square brackets, such as [y]. Note the following when responding to prompts:

• Press Enter to accept the default.

• For hostname, supply a fully qualified domain name (<hostname>.<domain>) or host name. This field is required.

• If you choose to configure IPv4 manually, the system prompts for IPv4 address, netmask, and default gateway. If
you choose DHCP, the system uses DHCP to assign these values. If you choose not to use DHCP, you must supply
values for these fields; use standard dotted decimal notation.

• Configuring a DNS server is optional; to specify no DNS server enter none. Otherwise specify IPv4 addresses for
one or two DNS servers. If you specify two addresses, separate them with a comma. (If you specify more than two
DNS servers, the system ignores the additional entries.) If your FMC does not have internet access you cannot use
a DNS outside of your local network.

If you are using an evaluation license, specifying DNS is optional at this time, but DNS is required to use
permanent licenses for your deployment.

Note

• You must enter the fully qualified domain name or IP address for at least one NTP server reachable from your
network. (You may not specify FQDNs for NTP servers if you are not using DHCP.) You may specify two servers
(a primary and a secondary); separate their information with a comma. (If you specify more than two DNS servers,
the system ignores the additional entries.) If your FMC does not have internet access you cannot use an NTP server
outside of your local network.

Example:

Enter a hostname or fully qualified domain name for this system [firepower]: fmc
Configure IPv4 via DHCP or manually? (dhcp/manual) [DHCP]: manual
Enter an IPv4 address for the management interface [192.168.45.45]: 10.10.0.66
Enter an IPv4 netmask for the management interface [255.255.255.0]: 255.255.255.224
Enter the IPv4 default gateway for the management interface [ ]: 10.10.0.65
Enter a comma-separated list of DNS servers or 'none' [CiscoUmbrella]: 208.67.222.222,208.67.220.220
Enter a comma-separated list of NTP servers [0.sourcefire.pool.ntp.org, 1.sourcefire.pool.ntp.org]:
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Step 6 The system displays a summary of your configuration selections. Review the settings you have entered.

Example:

Hostname:                           fmc
IPv4 configured via:                manual configuration
Management interface IPv4 address:  10.10.0.66
Management interface IPv4 netmask:  255.255.255.224
Management interface IPv4 gateway:  10.10.0.65
DNS servers:                        208.67.222.222,208.67.220.220
NTP servers:                        0.sourcefire.pool.ntp.org, 1.sourcefire.pool.ntp.org

Step 7 The final prompt gives you the opportunity to confirm the settings.

• If the settings are correct, enter y and press Enter to accept the settings and continue.

• If the settings are incorrect, enter n and press Enter. The system prompts for the information again, beginning with
hostname.

Example:

Are these settings correct? (y/n) y
If your networking information has changed, you will need to reconnect. 

Updated network configuration. 

Step 8 After you have accepted the settings, you can enter exit to exit the FMC CLI.

What to do next

• You can connect to the FMCv web interface using the network information you have just configured.

• Review the weekly maintenance activites the FMC configures automatically as a part of the initial
configuration process. These activities are designed to keep your system up-to-date and your data backed
up. See Review Automatic Initial Configuration for Versions 6.5 and Later, on page 103 .

• You can configure the FMC for IPv6 addressing after completing the initial setup using the web interface
as described in the Firepower Management Center Configuration Guide for your version.

Perform Initial Setup at the Web Interface for Versions 6.5 and
Later

After you deploy a FMCv, you can perform initial setup using HTTPS at the appliance web interface.

When you log into the FMC web interface for the first time, the FMC presents an Initial Configuration Wizard
to enable you to quickly and easily configure basic settings for the appliance. This wizard consists of three
screens and one pop-up dialog box:

• The first screen forces you to change the password for the admin user from the default value of Admin123.

• The second screen presents the End User License Agreement (EULA), which you are required to accept
before using the appliance.
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• The third screen allows you to change network settings for the appliance management interface. This
page is prepopulated with current settings, which you may change.

• The wizard performs validation on the values you enter on this screen to confirm the following:

• Syntactical correctness

• Compatibility of the entered values (for instance, compatible IP address and gateway, or DNS
provided when NTP servers are specified using FQDNs)

• Network connectivity between the FMCv and the DNS and NTP servers

The wizard displays the results of these tests in real time on the screen, which allows you to make
corrections and test the viability of your configuration before clicking Finish at the bottom of the screen.
The NTP and DNS connectivity tests are nonblocking; you can click Finish before the wizard completes
the connectivity tests. If the system reports a connectivity problem after you click Finish, you cannot
change the settings in the wizard, but you can configure these connections using the web interface after
completing the initial setup.

The system does not perform connectivity testing if you enter configuration values that would result in
cutting off the existing connection between the FMCv and the browser. In this case the wizard displays
no connectivity status information for DNS or NTP.

• After you have completed the three wizard screens, a pop-up dialog box appears that offers you the
opportunity to (optionally) quickly and easily set up Smart Licensing.

When you have completed the Initial Configuration Wizard and completed or dismissed the Smart Licensing
dialog, the system displays the device management page, described in “Device Management Basics” in the
Firepower Management Center Configuration Guide for your version.

Before you begin

• Be sure you have the following information needed for the FMC to communicate on your management
network:

• An IPv4 management IP address.

The FMC management interface is preconfigured to accept an IP4 address assigned by DHCP.
Consult with your system administrator to determine what IP address your DHCP has been configured
to assign to the FMC MAC address. In scenarios where no DHCP is available, the FMC management
interface uses the IPv4 address 192.168.45.45.

• A network mask and a default gateway (if not using DHCP).

• If you are not using DHCP, configure a local computer with the following network settings:

• IP address: 192.168.45.2

• Netmask: 255.255.255.0

• Default gateway: 192.168.45.1

Disable any other network connections on this computer.

Step 1 Use a web browser to navigate to the FMCv’s IP address: https://<FMC-IP>.
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The login page appears.

Step 2 Log into the FMCv using admin as the username and Admin123 as the password for the admin account. (The password
is case-sensitive.)

Step 3 At the Change Password screen:

a) (Optional) Check the Show password check box to see the password while using this screen.
b) (Optional) Click the Generate Password button to have the system create a password for you that complies with the

listed criteria. (Generated passwords are nonmnemonic; take careful note of the password if you choose this option.)
c) To set a password of your choosing, enter a new password in the New Password and Confirm Password text boxes.

The password must comply with the criteria listed in the dialog.

The FMC compares your password against a password cracking dictionary that checks not only for many
English dictionary words but also other character strings that could be easily cracked with common password
hacking techniques. For example, the initial configuration script may reject passwords such as "abcdefg"
or "passw0rd".

Note

On completion of the initial configuration process the system sets the passwords for the two admin accounts
(one for web access and the other for CLI access) to the same value. The password must comply with the
strong password requirements described in the Firepower Management Center Configuration Guide for
your version. If you change the password for either admin account thereafter, they will no longer be the
same, and the strong password requirement can be removed from the web interface admin account.

Note

d) Click Next.

Once you click Next on the Change Password screen and the wizard has accepted the new admin password, that
password is in effect for both the web interface and CLI admin accounts even if you do not complete the remaining
wizard activities.

Step 4 At the User Agreement screen, read the EULA and click Accept to proceed.

If you click Decline the wizard logs you out of the FMCv.

Step 5 Click Next.

Step 6 At the Change Network Settings screen:

a) Enter a Fully Qualified Domain Name. If default value is shown, you may use that if it is compatible with your
network configuration. Otherwise, enter a fully qualified domain name (syntax <hostname>.<domain>) or hostname.

b) Choose the boot protocol for the Configure IPv4 option, either Using DHCP or Using Static/Manual.
c) Accept the displayed value, if one is shown, for IPv4 Address or enter a new value. Use dotted decimal form (for

example, 192.168.45.45).

If you change the IP address during initial configuration, you need to reconnect to the FMC using the new
network information.

Note

d) Accept the displayed value, if one is shown, for Network Mask or enter a new value. Use dotted decimal form (for
example, 255.255.0.0).

If you change the network mask during initial configuration, you need to reconnect to the FMC using the
new network information.

Note

e) You can accept the displayed value, if one is shown, for Gateway or enter a new default gateway. Use dotted decimal
form (for example, 192.168.0.1).
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If you change the gateway address during initial configuration, you may need to reconnect to the FMC
using the new network information.

Note

f) (Optional) For DNS Group you can accept the default value, Cisco Umbrella DNS.

To change the DNS settings, choose Custom DNS Servers from the drop-down list, and enter IPv4 addresses for
the Primary DNS and Secondary DNS. If your FMC does not have internet access you cannot use a DNS outside
of your local network. Configure no DNS Server by choosing Custom DNS Servers from the drop-down list and
leaving the Primary DNS and Secondary DNS fields blank.

If you use FQDNs rather than IP addresses to specify NTP servers, you must specify DNS at this time. If
you are using an evaluation license DNS is optional, but DNS is required to use permanent licenses for
your deployment.

Note

g) For NTP Group Servers you can accept the default value, Default NTP Servers. In this case the system uses
0.sourcefire.pool.ntp.org as the primary NTP server, and 1.sourcefire.pool.ntp.org as the secondary NTP server.

To configure other NTP servers, choose Custom NTP Group Servers from the drop-down list and enter the FQDNs
or IP addresses of one or two NTP servers reachable from your network. If your FMC does not have internet access
you cannot use an NTP server outside of your local network.

If you change network settings during initial configuration, you need to reconnect to the FMC using the new
network information.

Note

Step 7 Click Finish.

The wizard performs validation on the values you enter on this screen to confirm syntactical correctness, compatibility
of the entered values, and network connectivity between the FMC and the DNS and NTP servers. If the system reports
a connectivity problem after you click Finish, you cannot change the settings in the wizard, but you can configure these
connections using the FMC web interface after completing the initial setup.

What to do next

• The system displays a pop-up dialog box that offers you the opportunity to quickly and easily set up
Smart Licensing. Using this dialog box is optional; if your FMCv will be managing Firepower Threat
Defense devices and you are familiar with Smart Licensing, use this dialog. Otherwise dismiss this dialog
and refer to ”Licensing the Firepower System” in the Firepower Management Center Configuration
Guide for your version.

• Review the weekly maintenance activites the FMC configures automatically as a part of the initial
configuration process. These activities are designed to keep your system up-to-date and your data backed
up. See Review Automatic Initial Configuration for Versions 6.5 and Later, on page 103 .

• When you have completed the Initial Configuration Wizard and completed or dismissed the Smart
Licensing dialog, the system displays the device management page, described in the Firepower
Management Center Configuration Guide.

• You can configure the FMC for IPv6 addressing after completing the initial setup using the web interface
as described in the Firepower Management Center Configuration Guide for your version.
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Review Automatic Initial Configuration for Versions 6.5 and
Later

As a part of initial configuration (whether performed through the Initial Configuration Wizard or through the
CLI), the FMC automatically configures maintenance tasks to keep your system up-to-date and your data
backed up.

These tasks are scheduled in UTC, which means that when they occur locally depends on the date and your
specific location. Also, because tasks are scheduled in UTC, they do not adjust for daylight saving time,
summer time, or any such seasonal adjustments that you may observe in your location. If you are affected,
scheduled tasks occur one hour "later" in the summer than in the winter, according to local time.

We strongly recommend you review the auto scheduled configurations, confirm that the FMC has established
them successfully, and adjust them if necessary.

Note

• Weekly GeoDB Updates

The FMC automatically schedules GeoDB updates to occur each week at the same randomly selected
time. You can observe the status of this update using the web interface Message Center. You can see the
configuration for this automatic update in the web interface under System > Updates > Geolocation
Updates>Recurring Geolocation Updates. If the system fails to configure the update and your FMC
has internet access, we recommend you configure regular GeoDB updates as described in the Firepower
Management Center Configuration Guide for your version.

• Weekly FMC Software Updates

The FMC automatically schedules a weekly task to download the latest software for the FMC and its
managed devices. This task is scheduled to occur between 2 and 3 AM UTC on Sunday mornings;
depending on the date and your specific location this can occur any time from Saturday afternoon to
Sunday afternoon local time. You can observe the status of this task using the web interface Message
Center. You can see the configuration for this task in the web interface under System > Tools >
Scheduling. If the task scheduling fails and your FMC has internet access, we recommend you schedule
a recurring task for downloading software updates as described in the Firepower Management Center
Configuration Guide for your version.

This task only downloads software patch and hotfix updates for the version your appliances are currently
running; it it your responsibility to install any updates this task downloads. See the Cisco Firepower
Management Center Upgrade Guide for more information.

• Weekly FMC Configuration Backup

The FMC automatically schedules a weekly task to perform a locally-stored configuration-only backup
at 2 AM UTC on Monday mornings; depending on the date and your specific location this can occur any
time from Saturday afternoon to Sunday afternoon local time. You can observe the status of this task
using the web interface Message Center. You can see the configuration for this task in the web interface
under System > Tools > Scheduling. If the task scheduling fails, we recommend you schedule a recurring
task to perform backups as described in the Firepower Management Center Configuration Guide for
your version.

• Vulnerability Database Update
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In Versions 6.6+, the FMC downloads and installs the latest vulnerability database (VDB) update from
the Cisco support site. This is a one-time operation. You can observe the status of this update using the
web interface Message Center. To keep your system up to date, if your FMC has internet access, we
recommend you schedule tasks to perform automatic recurring VDB update downloads and installations
as described in the Firepower Management Center Configuration Guide for your version.

• Daily Intrusion Rule Update

In Versions 6.6+, the FMC configures a daily automatic intrusion rule update from the Cisco support
site. The FMC deploys automatic intrusion rule upates to affected managed devices when it next deploys
affected policies. You can observe the status of this task using the web interface Message Center. You
can see the configuration for this task in the web interface under System > Updates > Rule Updates. If
configuring the update fails and your FMC has internet access, we recommend you configure regular
intrusion rule updates as described in the Firepower Management Center Configuration Guide for your
version.
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C H A P T E R 12
Firepower Management Center Virtual Initial
Administration and Configuration

After you complete the initial setup process for a Firepower Management Center Virtual (FMCv) and verify
its success, we recommend that you complete various administrative tasks that make your deployment easier
to manage. You should also complete any tasks you skipped during the initial setup, such as licensing. For
detailed information on any of the tasks described in the following sections, as well as information on how
you can begin to configure your deployment, see the complete Firepower Management Center Configuration
Guide for your version.

• Individual User Accounts, on page 105
• Device Registration, on page 106
• Health and System Policies, on page 106
• Software and Database Updates, on page 106

Individual User Accounts
After you complete the initial setup, the only web interface user on the system is the admin user, which has
the Administrator role and access. Users with that role have full menu and configuration access to the system.
We recommend that you limit the use of the admin account (and the Administrator role) for security and
auditing reasons. In the FMC GUI, manage user accounts on the System > Users > User page.

The admin accounts for accessing a FMC using the shell and accessing an FMC using the web interface are
not the same, and may use different passwords.

Note

Creating a separate account for each person who uses the system allows your organization not only to audit
actions and changes made by each user, but also to limit each person’s associated user access role or roles.
This is especially important on the FMC, where you perform most of your configuration and analysis tasks.
For example, an analyst needs access to event data to analyze the security of your network, but may not require
access to administrative functions for the deployment.

The system includes ten predefined user roles designed for a variety of administrators and analysts using the
web interface. You can also create custom user roles with specialized access privileges.
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Device Registration
An FMC can manage any device, physical or virtual, currently supported by the Firepower system:

• Firepower Threat Defense—Provides a unified next-generation firewall and next-generation IPS device.

• Firepower Threat Defense Virtual—A 64-bit virtual device that is designed to work in multiple hypervisor
environments, reduce administrative overhead, and increase operational efficiency.

• Cisco ASA with FirePOWER Services (or an ASA FirePOWER module)—Provides the first-line system
policy and passes traffic to the Firepower system for discovery and access control. However, you cannot
use the FMC web interface to configure ASA FirePOWER interfaces. Cisco ASA with FirePOWER
Services has a software and CLI unique to the ASA platform that you can use to install the system and
to perform other platform-specific administrative tasks.

• 7000 and 8000 Series appliances—Physical devices purpose-built for the Firepower system. 7000 and
8000 Series devices have a range of throughputs, but share most of the same capabilities. In general,
8000 Series devices are more powerful than 7000 Series devices; they also support additional features
such as 8000 Series fastpath rules, link aggregation, and stacking. You must configure remote management
on the device before you can register the device to an FMC.

• NGIPSv—A 64-bit virtual device deployed in the VMware VSphere environment. NGIPSv devices do
not support any of the system’s hardware-based features such as redundancy and resource sharing,
switching, and routing.

To register managed devices to an FMC use the Devices > Device Management page on the FMC GUI; see
the device management information in the Firepower Management Center Configuration Guide for your
version.

Health and System Policies
By default, all appliances have an initial system policy applied. The system policy governs settings that are
likely to be similar for multiple appliances in a deployment, such as mail relay host preferences and time
synchronization settings. We recommend that you use the FMC to apply the same system policy to itself and
all the devices it manages.

By default, the FMC also has a health policy applied. A health policy, as part of the health monitoring feature,
provides the criteria for the system to continuously monitor the performance of the appliances in your
deployment. We recommend that you use the FMC to apply a health policy to all the devices it manages.

Software and Database Updates
You should update the system software on your appliances before you begin any deployment. We recommend
that all the appliances in your deployment run the most recent version of the Firepower system. If you are
using them in your deployment, you should also install the latest intrusion rule updates, VDB, and GeoDB.
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Before you update any part of the Firepower system, you must read the release notes or advisory text that
accompanies the update. The release notes provide important information, including supported platforms,
compatibility, prerequisites, warnings, and specific installation and uninstallation instructions.

Caution

If your FMC is running Firepower Versions 6.5+:

As a part of configuration the FMC establishes the following activities to keep your system up-to-date and
your data backed up:

• Weekly automatic GeoDB updates

• A weekly task to download the latest software for the FMC and its managed devices

This task only downloads software updates to the FMC. It is your responsibility
to install any updates this task downloads. See the Cicso Firepower Management
Center Upgrade Guide for more informaction.

Important

• A weekly task to perform a locally-stored configuration-only FMC backup

If your FMC is running Firepower Versions 6.6+, as a part of initial configuration the FMC downloads
and installs the latest vulnerability (VDB) update from the Cisco support site. This is a one-time operation.

You can observe the status of these activities using the web interface Message Center. If the system fails to
configure any of these activities and your FMC has internet access, we recommend you configure these
activities yourself as described in the Firepower Management Center Configuration Guide for your version.
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